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SPECTRORADIOMETER 1

Section 1 - Spectroradiometer

1. INTRODUCTION

This User Manual applies to the following SVC field-portable spectroradiometer products:

I Wavelength . InGaAs | InGaAs
nstrument Total Si
Model Range Bands Spectrometers Bands #1 #2
(nm) Bands Bands
XHR-1024i | 350 - 2500 1024 3 512 256 256
HR-1024i 350 - 2500 1024 3 512 256 256
HR-768i 350 - 2500 768 3 512 128 128
HR-640i 350 - 2500 640 3 512 64 64
HR-768si 350 - 1900 768 2 512 256 n/a
HR-512i 350 - 1050 512 1 512 n/a n/a

Each instrument includes memory and a display for stand-alone operation as well as capability for personal
computer (PC) and personal data assistant (PDA) assisted operation. PC communications to the
instrument are available through its USB client port, a Bluetooth witeless connection, or via RS-232. A
PDA may control the instrument via a Bluetooth connection or via RS-232.

The instruments include a second Bluetooth channel that may optionally communicate with an external
sensor suite.

When operated in stand-alone mode, up to 1000 spectral readings can be stored within the instrument for
subsequent down loading and analysis using a PC. All spectroradiometer identification and calibration
information is stored on board, so there are no external files to manage.

The instrument contains an internal GPS device to record the latitude, longitude, and time of each spectral
reading.

This instrument is self contained and incorporates an easily replaceable battery pack. The battery chargers
supplied with the instrument have the capability to charge the LI-Ion batteries from line voltage with the
AC adapter.

The computer based operation allows for real time data display and data analysis. Radiance and percent
reflectance are provided within the acquisition software. Stand-alone operation makes this same
information available for display on the instrument’s LCD (liquid crystal display), which is located on the
rear panel on the instrument.

A full range of options are available. These options include alternate foreoptics, fiber optic light guides,
irradiance spheres, cosine diffusers, Reflectance Probe, back packs, white reference panels, tripods and
other custom engineered field devices.
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SPECTRORADIOMETER 2

2. HARDWARE DESCRIPTION

CONTROL PANEL

LIFTING IK /

LASER
SCAN
SWITCH

HAND STRAP /

TRIPOD MOUNT

TR

FOREOPTIC
(4° FOV)

Figure 1 Instrument Attached To Tripod Via Front Panel

Tripod Mounting Options

The instrument can be mounted to a tripod on the front panel (as shown in Figure 1 above) using one or
more of five 1/4-20 UNC threaded holes that are compatible with most conventional photographic or
video tripods. Alternatively, a tripod can be mounted at the bottom of the optical plate (as shown in
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SPECTRORADIOMETER 3

Figure 2 below) where the holes’ locations are near the center of gravity of the instrument with battery
pack installed.

BATTERY PACK (PARTIALLY USB-B
RETRACTED) CONNECTOR

BATTERY __

CONTACTS

COOLING MODULE
POWER CONNECTOR

SUPPORT FOOT
(RETRACTED)

TRIPOD MOUNTING HOLES

Figure 2 Instrument Bottom View
Foreoptic Options

Different foreoptics can be attached to provide different fields of view (FOV) to enable the instrument to
look at different size targets. Normally the target is at a distance of 1m from the optical element. See
section 3 item 1 for the field of view setup. Measurements can be taken at further distances but the target
size will be larger. The foreoptics are mounted in lens barrels or adapters that are secured to the unit by
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SPECTRORADIOMETER 4

hand using a threaded collar and are keyed to go in at the same clock angle to maintain consistent
radiometric readings. The following foreoptics are available:

(1) 4° nominal FOV lens (standard)

(2) 8° nominal FOV lens (optional)

(3) 14° nominal FOV lens (optional)

(4) 25° FOV fiber optic light guide, vatious lengths (optional)
(5) 180° Irradiance Sphete (optional)

NOTES: Wihen optics are installed or changed, the proper radiometric calibration must be applied to the software.

The entry of this information is provided for in the Control -> Setup software section of the manual. Abvays screw the
threaded collar until hand tight point. Do not over-tighten.

Battery Pack

The instrument’s Battery Pack provides power for portable operation. The battery pack installs via
dovetail slides and automatically latches into position to engage the battery contacts on the bottom of the
instrument. The Li-ION battery is 7.4V nominal and connects directly to the instrument. This battery is
designed to provide over 3 hours operation following a full charge. When the battery is inserted, power
can be applied to the instrument. When the battery voltage is too low to power the instrument, it will turn
off and go to 0 volts. The battery can then be charged via the charging connector with the supplied
charger. Refer to Section 4 — Battery Charger for charging details.

PULL HANDLE

COVER
PLATE

CHARGE JACK ELECTRICAL CONTACTS

Figure 3 Battery Pack
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SPECTRORADIOMETER 8§

FRONT PANEL

TRIPOD
MOUNTING
HOLES

JPG CAMERA
WINDOW

LASER

POINTER
WINDOW FOREOPTIC FOREOPTIC

RETAINING RING (8° FOV)

Figure 4 Front Panel

Support Feet

Support feet can be moved between the retracted and extended positions. When extended they allow the
instrument to rest level on a flat surface when the battery pack is installed.

Hand Strap

The hand strap is adjustable and allows holding of the instrument with the right hand whilst actuating the
laser scan switch with the right index finger.
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SPECTRORADIOMETER 6

Laser Scan Switch

The Laser Scan Switch is a pushbutton type that can both actuate the sighting laser and initiate the start of
the spectral scan. (More detail is provided in Section 3).

Laser Pointer

The laser beam projects thru the laser pointer window close to the objective lenses and is aligned parallel
to the axis of these lenses.

JPEG Camera

The internal JPEG camera views thru a protective window as shown above. Itis a miniature camera with a
40° field of view and is focused for maximum depth of field from 1m to infinity. It outputs a either a
640x480 or 320x240 pixel image of the spectral target sample and surrounding area.

3. CONTROL PANEL

The control panel of the instrument contains the controls and displays that are required for stand alone

operation.
EXTERNAL AUX. BLUETOOTH
BLUETOOTH TRIGGER LCD DISPLAY ANTENNA
ANTENNA CONNECTOR CONNECTION

POWER
GPS ANTENNA SWITCH
USB A PORT

Figure 5 Control Panel

Data Connections

The instrument has 3 connectors that may be used to communicate with external devices; two of these
connections are located on the Control Panel, one is located on the bottom of the unit:
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SPECTRORADIOMETER 7

AUX The AUX port is a round 12-pin connector located on the left side of
the control panel. It serves as an RS-232 serial port, an external
trigger connector, and as a source of power for optional equipment.

USB A The USB A Port is for future use. The USB client port on the
bottom of the instrument is for computer assisted operation.
Bluetooth The Bluetooth antenna is for computer assisted operation.
LED Indicators

The Control Panel has 3 LED status indicators.

Laser LED The laser indicator is illuminated when the laser is on.
Ready LED Is illuminated when the instrument is ready to take a scan.
Power LED The power indicator is illuminated when the power is on.

Power Switch

The power switch provides on/off control of the unit.

GPS Antenna

The GPS Antenna dome is positioned on the control panel for optimal orientation for receiving signals
from a GPS satellite when the instrument is in the typical orientation of pointing downwards to look at a
spectral target.

LCD Display

The LCD display is useful for acquiring spectral data in stand-alone operation (see section 3 item 3). Itisa
standard 4.3” diagonal module with LED backlighting and a 480 x 272 pixel resolution, incorporating a
resistive touch screen designed to use finger inputs (no stylus needed.) Text and icons are high contrast,
designed to be read in direct sunlight conditions. Spectral plots are viewable from the display.
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SPECTRORADIOMETER 8

Section 2 — PC Data Acquisition Software

1. INSTALLATION/REMOVAL

The instrument’s PC Data Acquisition Software is supplied either on CD or in single-executable format,
and provides for step-by-step installation onto a Windows PC or notebook computer.

The installation media is used to install the PC Data Acquisition software into an installation directory
(typically, C:\Program Files(x86)\Spectra Vista\ [Instrument Model)|\) on the computet’s hard disk drive.

Recommended System Requirements

*  Operating System: Windows 7 / 8 / 8.1 / 10

*  CPU Speed: 500Mhz (or greater)

*  Memory: 1G (or greater) of main memory

*  Screen Resolution: 1024x768 (or greater)

e Serial / USB port: Provided by a built-in COM (9-pin D) pott, a USB-to-Serial Adapter, or via a
Bluetooth interface (Bluetooth Serial Port)

Installation Steps

Prior to installation, reboot the computer to ensure that Windows is in a stable state, and has as few
applications running as possible.

To install the software from the CD, simply insert the installation CD into the CD drive within the
computer where you want to install the software. A screen similar to the one shown below will appear in
less than 1 minute. Follow the on-screen prompts to install the PC Data Acquisition software.

¥C HR-1024i PC Data Acquisition Software ¥1.4 - InstallShiel " x|

Welcome to the InstallShield Wizard for S¥C
HR-1024i PC Data Acquisition Software V1.4

The InstallShield{R) Wizard will install SWC HR-1024i PC Data
Acquisition Software ¥1.4 on your computer, To continue, click
Mexk,

WARNING: This program is protected by copyright law and
international treaties.

Cancel

< Back

If the screen shown above does not appear within 60 seconds:

Use Windows Explorer to explore the CD.

Double-click on the “setup.exe” file located on the CD in order to manually run the setup.
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SPECTRORADIOMETER 9

Removing The Software

The Data Acquisition Software may be removed by using the standard Windows program removal tool
found under Control Panel -> Programs and Features. Scroll down through the list of installed programs and
select the entry “SVC HR-XXXXi Data Acquisition Software”. Press the “Remove” or “Uninstall” button
to remove the software:

Note that only the software will be removed; any data files acquired will remain on the computer’s disk.

2. INTRODUCTION

The PC Data Acquisition Software provides the user with a flexible, easy to use software package. The PC
Data Acquisition Software is used to acquire data from the instrument, store data to files on disk, and
display data graphically.

The PC Data Acquisition Software can modify spectroradiometer parameters, take spectral measurements,
and download spectral measurements from the on-board memory of the instrument to files on disk. The
PC Data Acquisition Software allows data to be configured and stored to a file on disk when taking a
spectral measurement.

The software has a number of features that provide a great deal of flexibility for spectral data acquisition,
display, and storage:

*  Data files can be configured as SIG Files for use with PC Data Acquisition Software; SIG
Files ate saved to disk and may read back into the PC Data Acquisition Software at a later
time for analysis.

*  Data files can be configured as user defined ASCII Files for export to other software
packages; ASCII format files cannot be read back into the PC Data Acquisition
Software at a later time.

*  Data files can be automatically created and given an incremental extension at the end of the
acquisition.

*  Data can be saved to a unique file name at the end of the acquisition.

*  New data may be acquired manually by clicking the mouse on a button or pressing a “hot
key”’; or new data may be taken automatically using a configurable timer.

*  Spectral data may be displayed in one of two ways:

0 “Single Graph” mode, which displays the Reference and Target Radiance on the left
Y-axis and the Percent Reflectance on the right Y-axis for a single measurement.

0  “Multi Graph” mode, which displays the Reference Radiance, Target Radiance, or
Percent Reflectance of up to 24 measurements in one graph.

Several tools are built into the software that allow SIG format data files to be merged, re-sampled, or re-
processed automatically (see the Tools Menu description below.)

The Data Acquisition Software’s initial screen is shown below.
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#.S¥C HR-1024i - [E:4Publici]

File Contral Tools Window  About

Reference Scan

Target Scan

—Flot Types
Reference Last Scan Information
Target L [ptic;

Reflectance :

Scan:
|nteg:
Temp:

Battery; [ |

~lofx|

[ [Wavelength: | Walue: | Matching Type: Mone

| Overlap: Prezerve 4

The screen above is divided into several areas, as
described below:

#.S¥C HR-1024i - [C:3Publict]

=10i x|

The application’s Title Bar displays the
Spectroradiometer Model Name and Current
Working Folder — that is, the folder where new scans
(real-time or downloaded) ate saved, and where old
scans may be opened and displayed.

The location of the current working folder is retained in
the Windows Registry.

The location of the current working folder may be
changed with the File->New... or File->Open...
dialogs.

File Control Tools ‘Window  Abouk

The Main Menu allows the operator to open/save files
and configure both the instrument settings and the
display of spectral data. Each menu item is discussed in
detail in subsequent sections.

Refterence Scan

The Reference Scan Button causes the instrument to
take and graphically display reference data. This button
may also be activated by pressing either the “R” or “F1”
key on the keyboard.
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T arget Scan

Acquire Multiple Target Scans

MNew Basename: [jarosite_a

Firzt Sequence #; ||'_]|:||_'|
Scanz ToAcguire: |5 '-'I

The Target Scan Button, when left-clicked, causes the
instrument to take and graphically display a single target
data set. This button may also be activated by pressing
either the “I”” or”F2” key on the keyboard.

The Acquire Multiple Target Scans dialog allows the
operator to take multiple scans of the same target
sequentially. This pop-up dialog appears when the
Target Scan Button is right-clicked, and may also be
activated by pressing the “M” or “I'4” key on the
keyboard.

Ext Data Scan

The Ext Data Scan Button only appears in the GUI
when the optional External Data Interface has been
installed in the instrument, and has been configured for
display. This button may also be activated by pressing
the “E” key on the keyboard.

See the section SETUP EXTERNAL DATA ... below for
more details.

Ext Data Dark

The Ext Data Dark Button only appears in the GUI
when the optional External Data Interface has been
installed in the instrument, and has been configured for
display. This button may also be activated by pressing
the “D” key on the keyboard.

See the section SETUP EXTERNAL DATA ... below for
more details.

The File Stack Area shows the list of data files that are
currently open. It also allows the operator to select
which files to graph in single-graph mode by double-
clicking.

n Flot Types-
Reference
Target &

Reflectance: & |

The Plot Types Control allows the operator to select
the type of data displayed in the graph area.

| Channek: | \wWavelength: ["alue:

The Status Bar Area displays the channel number, the
wavelength, and the Radiance/ Reflectance value of a
selected data point on a displayed graph.

A data point in a graph is selected by moving the cursor
to the point of interest, and clicking the left mouse
button on the point.
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r Last Scan Information
Optic; Ophic1(1]

Scan: 1 Sec, Auto Dark,
Inteq: Auko, 200, 24 20

Temp: 450,.0.1,-54

Battery: [N |

The Last Scan Information Box shows information
about the last reference or target scan acquired by the
Data Acquisition Software.

Extemal [ata Dizplay
Channel:
Drark:
Feference:
Lazt Scan:
Lazt Scan Z: 0

e e e T

il

o T T e e B

8

The External Data Display Frame only appears in the
GUI when the optional External Data Interface has
been installed in the instrument, and configured for
display.

See the section SETUP EXTERNAL DATA ... below for
more details.

# alunite.sig

Kaolinite,sig

soilsig

\

% Reflectance

T
6829 985.7 12885 15914 18643

The large white area displays single-graph or multi-graph
data sets. The Graphing Area operates in two modes,
Z.oom Mode and Normal Mode.

ZOOM MODE: A rectangular area of interest may be
magnified by holding down the left mouse button while
“dragging” a rectangular area across the graph. When
the left mouse button is released, the graph is re-drawn
to contain only the dragged rectangle.

NORMAL MODE: Click the right mouse button
anywhere in the graph area to restore the magnification
to normal.
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3. DESCRIPTION

Menu Selection Summary
The application’s main menu bar is shown below:

Eile Control Tools Window About

File Provides a menu of options pertaining to Data Files.

Control Provides a menu of options to control Spectroradiometer operations.
Tools Provides a menu of available tools for enhancing spectral data files.
Window Provides a menu of available Window displays and settings.

About Provides a dialog box of software and spectroradiometer data.

File Menu

The File menu item provides the following drop-down menu of file controls.

NEW

Modifies the filename configuration used for storing spectral measurement when
the ‘Autosave’ feature is being used.

File | Control Tools Window About

_(_ New... _)

Open...
Save Az,

Close
Close All
Print...

Data Options r
Exit

The following standard Windows file dialog box appears when “New” is selected. Note
that the dialog style may vary slightly with different versions of the Windows OS.
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Enter the new filename base... ?I XI
Look in; |E}Data ﬂ = & ¥ B

4] ar072505_000,5ig
4] ar072505_001 ,5ig
4] ar072505_002,5ig
4] gr072505_003.5ig
4] ar072505_004,5ig
4] gr072505_005.5ig
4] ar072505_006,5ig

File riarme: || j Open
Files l:ufg.qpe:-- IEnter Mew Bazename Above - Mo E stension! j ‘LCancel |
: ! : 4| .
File name Modifies the Base of the filename used with the Autosave

feature. The filename of a spectral measurement acquired in
Autosave mode is the File Base with an incremental extension
automatically provided by the software.

Ex. If the file base is “Test”, the first filename is
“Test_0000.sig™, the second is “Test._0001.5ig”, ete. ..

When entering the new base name into the File name box, do
not include any filename extensions, as the software will
automatically add the appropriate extension as each data set is
acquired.

Files list Displays the files that exist in the current drive, directory, and
search pattern.

File of type This box has no purpose other than to display instructions to
the user.

Open Accepts the new base file name entered.

Cancel Cancels the operation.
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OPEN
Opens the files to be displayed in multi-graph mode.

[ﬁie Control  Tools Window About

Mew...

o )

Save As..,

Close
Close All
Print...

Data Options »

Exit

The following standard Windows file open dialog box appears when “Open” is selected.
Note that the dialog style may vary slightly with different versions of the Windows OS.

2
Laok in; |E}Data ﬂ = & cF E-

4] ar072505_000,5ig
4] ar072505_001 ,5ig
4] ar072505_002,5ig
4] gr072505_003.5ig
4] ar072505_004,5ig
4] gr072505_005.5ig
4] ar072505_006,5ig

File: marne: I j Open
Files of type; | Sig Files [*.sig) =] ‘Cancel /|_
i
File name Selects the file(s) to be opened. A single left-mouse click

selects a single fields or <Ctrl> + left-click or <Shift> + left-
click can be used to select multiple files.

NOTE: The multi-graph is limited to twenty-four (24) plots.
File Type Modifies the cutrent search pattern used for displaying the

existing files in the Files Box. Only “SIG” format files may be
opened by the Data Acquisition software.
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Open Opens the selected file(s) for display in the multi-graph.

Cancel Exits the dialog box without opening a file.
SAVE AS ...

Saves the data that is currently contained in the single graph.
In order to use the Save As... function, the graphing
software must be in Single Graph mode, displaying the
data file that is to be saved.

File | Control Tools Window About

MNew...
Open..,
( Save As.. )
Close
Close All
Print...

Data Options »

Bxit

The following standard Windows file save dialog box appears when “Save As” is selected.
Note that the dialog style may vary slightly with different versions of the Windows OS.

21
Séh{E:'ini Il.':_} Data j L Ejﬁ v

| 1] gro72505_000,5ig
4] gr072505_001.5ig
4] gr072505_002.5ig
4] gr072505_003.5ig
4] gr072505_004.5ig
14] gr072505_005.5ig
4] gr072505_006.sig

File name: j Save I
Save as type: Sig Files [7 sig] : Cancel |
i i

File name Allows the desired filename for data storage to be entered. If
no extension or an invalid extension is entered, then one is
supplied, based on the current file format.
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Files list Displays the files that exist in the current drive, directory, and
search pattern.

Save As Type Modifies the current search pattern used for displaying the
existing files in the Files Box. Only the currently selected
format may be saved. The file format is selected by using the
File->Data Options->Format menu to choose between “SIG”
and “ascii” output file format.

Save Saves the data contained in the single graph to the specified
filename and exits the dialog box.

Cancel Exits the dialog box without saving the file.

CLOSE

Closes the data files that are selected in the File Stack of the multi-graph.
The multi-graph is redrawn after the files are closed.

CLOSE ALL

Closes all files in the File Stack.

_[@ Control  Tools \'\"lndcmr About
- MNew... '
Open..,
| Save As..,
(_ Close _)
| Close Al
Print...

Data Options »

Bxit

PRINT

Opens a standard Windows print dialog box. The current graph view
may be printed using this dialog.

_[@ Control  Tools \'\"lndcmr About
- MNew... '

Open..,

Save As..

Close

Close All

(_ Print... J

Data Options »

Bxit
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DATA OPTIONS
Configures how and when spectral measurements are stored to a files on
a disk.
File | Control Tools Window About
MNew... '
Open..,
Save As..,
Close
Close 4ll
Print... [
| ¥ | Autosave
(_ Data Options '_) Prompt For Save
- |
Bwt Format... ‘
Autosave When this item is checked, the Autosave feature is turned

on. When Autosave is on, spectral measurements are
automatically saved to files on disk using the current File
Basename and an incremental extension. The default
filename configuration uses the installation data directory
(typically C:\Program Files\Spectra
Vista\HR1024i\Data\) and the current File Basename
determined by “gr” and the month, day, and year (Ex.
“or052105”).

When the Autosave is turned on, the Prompt For Save
option is disabled.

Prompt For Save When this item is checked, the operator is prompted for a
filename to store the data after the completion of each
spectral measurement.

Format... Configures the data output file.

Choosing “Format...” displays the following dialog box:

& Output File Format @
Output File Format -
Sig File
Azl File

3 B B e i

Save Flaw Dark Data [~

0K

Output File Format ~ Provides for the selection of one of the following:

*  SIG FileThis is the format compatible with the PC
Data Acquisition software; spectral data saved in this
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format may be read back and displayed at some
future time by the PC Data Acquisition Software

*  Ascii File Check the column(s) of data that will
appear in the ASCII data file. The options are:

Header information, including instrument
settings, date/time, etc.

Wavelength in nanometers
Reference Radiance in W/cm?2/nm/sr*10-10
Target Radiance in W/cm?2/nm/ sr*10-10
Percent Reflectance
Save Raw Dark Data
Checking this box will cause the softwarte to save the
“raw’” dark detector data associated with each scan. With

each target scan acquisition, this raw dark detector data is
saved to a separate file with the file name extension

<« LR}

faw'.

OK Implements the selected file format and exits the dialog
box.

Cancel Ignores the modifications made to the file format and
exits the dialog box.

EXIT

Exits the PC Data Acquisition Softwatre program.

File | Control Tools Window About

New...
Open...
Save As..
Close
Close All
Print...

Data Options r

(_ Exit )

Control Menu

The control menu item provides the following drop-down menu of instrument controls:
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SETUP INSTRUMENT...

Tools Window About

Configures the Computer Port used for communications with the instrument.
Once connected, sets the spectroradiometer operating parameters.

C

Setup Instrument...

Setup Overlap/Matching...
Setup External Data..,
Read Mermary...

Timed Scans...

Setup GPS...

Setup Water Quality Interface...

Long Term Timer..,

When “Setup Instrument...” is selected, the software presents the following

setup dialog box:

T

X

— Computer Port Cantrol
€ et Tl Contiglied Parts
= [ist 8] Possle Forts

[BETKEEN - |

Dizconnect | Lonmect |

—HR-1024i Settings

Optic: [opTicT =]

—Scan Timing

{* Specify Total Scan Time [Sec):

F =

o
Swir Irj
o

™ Specify Coadds:

S

—|ttegration Time [mS eu:_]

Sifso =

Stairts |20 :I'

-

v Auto Integration

Simir

Date: [02/04/13 =

Stored Scang ID
Target Phota Acquisition: INDne 1'l

v Integration Scales Raw DM Data

Time: [16:2319 =

Cahcel | (] 4 |

SVC XHR-1024i /| HR-1024i /| HR-768i / HR-640i / HR-768si / HR-512i USER MANUAL REV 1.13



SPECTRORADIOMETER 21

Computer Port Control Frame:

List Only Configured Ports When selected, only ports that are
physically configured into the host
computer are listed in the Port control.
The list of configured ports is built only
once each time the Data Acquisition
Program is run.

List All Possible Ports When selected, all 255 ports are listed in
the Port control. Use this option if a
virtual port (usually a Bluetooth port) that
you want to use is not present in the
“configured” list above.

Port Selects/displays the serial
communications COM port used to
communicate with the instrument.

The actual physical hardware associated
with the COM port may be provided by a
standard DB-9 hardware interface
installed in the PC; It may also be realized
by several other means that provide a
“virtual” COM port (Bluetooth Serial
Port, USB-to-Serial Adapter, or USB
COM driver). See the Operations section,
sub-section 2. Connecting The
Instrument To A Computer, for more
details.

Connect (left-mouse-click) Establishes a connection to the
instrument at the standard baud rate, and
downloads the information necessary to
acquire and process spectral data.

Connect (right-mouse-click) Displays a confirming dialog box (see
below), then establishes a connection to
the instrument at the low speed baud
rate, and downloads the information
necessary to acquire and process spectral
data. Note that using this option will
significantly slow down spectrometer
operation.

Host Port Speed Select
Connect to the instrument using special LOW SPEED (9600 Baud)?

NOTE: Only wired (R5-232, USB) connections support Host Port LOW SPEED,
and the instrument's AUX HOST SPD setting must be set to LOW SPEED

Mo Cancel

Disconnect Closes the connection.
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Settings Frame Modifies the instrument settings. This
frame is only enabled after the PC
Acquisition Software has established a
connection with an instrument.

Optic Selects the entrance optic that is currently
installed on the instrument.

NOTE: The Special “RAW DN”
entrance optic provides raw
measurements without any radiometric
calibration applied.

Scan Timing Frame: Scan time may be control in two ways,
either by specifying the amount of time
spent on the light scan, or by specifying
the number of sub-scans (Coadds)
acquired from each spectrometer.

Specify Total Scan Time Scan data will be acquired using a total
light scan time, which controls how long
(in seconds) a spectral scan will take.
Higher settings can reduce noise, but
scans will take longer to complete. Any
integral scan time from 1 to 15 seconds is
supported.

Specify Coadds Scan data will be acquired by taking a
specific number of Coadds from each
spectrometer, regardless of the total
amount of time required, up to a
maximum of 15 seconds. If this time
limit is reached before the number of
specified Coadds has been acquired, then
the scan is terminated and the actual
number of Coadds is reported in the Sig

file.

Integration Time Frame: Using this control, the operator may
select between auto- and fixed-integration
modes.

Integration Time The time in milliseconds allowed for the

individual detectors to accumulate a
single Coadd. Higher settings can reduce
noise, but the scans will take longer to
complete and may saturate.

Auto The “Auto” check box allows the
instrument to automatically select the
optimum integration time for each
spectrometet.
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Date/Time Displays the current date/time stored in
the instrument’s real time clock. If the
displayed date/time is changed, the new
settings are downloaded to the
instrument if the “OK” button is
selected.

Stored Scans Displays the number of scans currently
stored in the instrument’s internal
memory.

Integration Scales RAW DN Data  When checked, and when the
instrument’s “RAW DN” optic is
selected, the RAW DN data will be scaled
appropriately by the reported integration
times. Use this checkbox when acquiring
reflectance data in RAW DN mode.

When unchecked, RAW DN data is not
scaled by the integration times.

Target Photo Acquisition Controls the type of photo that is
acquired along with each target scan:
OFF: No target photo.
LO: Low resolution (320x240) photo.
HI: High resolution (640x480) photo.

Note that taking target photos will
increase the amount of time to acquire
and download scan data from the
instrument to the PC.

OK If connected to an instrument, the
settings shown are downloaded to the
instrument, and the dialog exits.

Cancel Exits the dialog without saving or sending
any instrument settings.

SETUP OVERLAP/MATCHING...

Configures how to handle overlapped detector data; note that this option is not
available in the SVC HR-512i software:

Eile | Control | Tools Window About
Setup Instrument...

( Setup Overlap/Matching... )
Setup External Data...

Read Mermary...

Timed Scans...

Setup GPS...

Setup Water Quality Interface. .

Long Term Timer..,
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When “Setup Ovetlap/Matching...” is selected, the software presents the
following dialog box.

- 0verlap / Matching Settings 1 |

- Dgtector Overlap Contrals
" Preserve Overlapped Detector Data
ey Remove Overlapped Detector Data

Si<x Swir] Transition Wyl {900 il-'

SwirT-» Swir2 Transition %k 11900 il-'

— Dietectar Matching Cantrols

- Matching Type i~ Matching Region

7 Mone .

: |

e Beaitining Wl {950 =

" Reflectance Ending ! 1000 ilJ
= Matching Factor Limits

Min: [oan = Maw: [110 =
- MIR-5WwWIR Overlap Algonthm
v LIze The MNIR-S%WIR Owverlap Algorithm
Within The Matching Fegion

;""§'é't'"fti'é'f'Eﬁii"ﬁ'é'l'&'é'é'"‘;| Cancel oK

Overlap Frame:

Preserve Overlapped Detector Data
When this option is selected, the
Transition Wvl setting is ignored and has
no effect. All spectral data is preserved in
the output file as each scan is acquired.

Remove Overlapped Detector Data
When this option is selected, the
Transition Wvl fields control where the
Si->Swirl and Swirl->Swir2 transitions
takes place. All overlapping spectral data
is removed.

Si->Swirl Transition Wvl When in “Remove Overlap” mode, Sets
the point where the Si detector data ends,
and the first InGaAs detector data begins,
when the “Remove Overlapped Detector
Data” option is selected.

Swirl->Swir2 Transition Wvl When in “Remove Overlap” mode, Sets
the point where the first InGaAs detector
data ends, and the second InGaAs
detector data begins, when the “Remove
Overtlapped Detector Data” option is
selected.
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Matching Type Frame Controls the method of matching Si and
InGaAs detector data.
None No matching take place. When this

option is in effect, none of the other
Matching parameters has any effect on
spectral data.

Radiance Uses the detectors’ radiance curve data to
perform matching on both the Reference
and Target scans separately.

Reflectance Combine the Reference and Target scans
into a reflectance curve, and uses this
curve’s data to perform matching.

Matching Region Frame Defines the region over which the Si and
first InGaAs data is examined in order to
perform detector matching.

Beginning Wvl The beginning wavelength in the
matching region. This settings has no
effect if “Matching Type” is set to
“None”.

Ending Wvl The ending wavelength in the matching
region. This setting has no effect if
“Matching Type” is set to “None”.

Matching Factor Limits Frame Defines the range of acceptable values
for the factor used to match Silicon data

to SWIR data.
Min The minimum matching factor value.
Max The maximum matching factor value.

Use NIR-SWIR Overlap Algorithm Frame

Use The NIR-SWIR Overlap Algorithm...
When checked, the Silicon and SWIR1
data are combined (within the Overlap
Region) using a combination of the two
overlapping detector data sets. Using this
option only affects the data within the
Overlap Region. This algorithm is applied
after the standard matching algorithm is
applied (See Matching Type Frame
instructions above).

SETUP EXTERNAL DATA ...

Configures the instrument’s optional external data interface.
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Eile | Control | Tools Window About

Setup Instrument...
Setup Overlap/Matching...

C

Setup External Data..,

Read Mermaory...
Timed Scans...

Setup GPS...

Setup Water Quality Interface...

Long Term Timer..,

The instrument may optionally be configured with an external sensor data
interface. This interface allows the PC software to digitize, display, and store
the data from up to 16 external sensors that are attached to the external
interface.

Currently, Spectra Vista supplies the WEDI-16 product to serve as an external
data interface. Contact Spectra Vista for details on this product.

The Setup External Data dialog determines which, if any, of the external
sensors’ data is saved to SIG files and/or displayed in the main GUI display.

When selected, the Setup External Data command displays the following
dialog:
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= bdernal Data Setup

Extemnal Data Source: JHFH 024i[viaBT] _j

Euternal Data Source Bluetooth Address
Bluetooth Address: {1 2747273417734

|Jpdate Instrument ‘

External Data Acguisition

Enabled Enabled
Ch. 1 [ Ch. 3 =
Ch. 2 v Ch. 10 [
Ch. 3 [ Ch.11 [
Ch. 4 v Ch.12 [~
Ch. B [ Ch.13 [
Ch. B v Ch. 14 [
Ch. 7 [ Ch. 1% [
Ch. & [ Ch. 16 [

Euternal Data Display

Display Ch. A: ]Ch_ 2 -
Display Ch. B: J[;h_ E -

o Adjust Dizplayed Yalues
For External Dark Current

Cancel Ok

External Data Source: Selects the source for the external data:

None — disables external data acquisition.

1-Series Model (Via BT) — use the
optional external Bluetooth data interface
within the connected instrument for
external data acquisition.

External Data Source Bluetooth Address Frame

Bluetooth Address Allows entry of the 12 digit hexadecimal
address of the external data source. This
address is used by the instrument to
establish a connection between the
insttument and the external data device.

The 12 digit Bluetooth address to use
in this box may be found on the label
attached to the bottom of the
customer’s external data device

(WEDI-16).
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Update Instrument Use this button to send the displayed

Bluetooth Address up to the instrument.
The instrument must be connected to the
PC in order for this button to be enabled.
Once the Bluetooth address is sent to the
instrument, the instrument will attempt to
establish a connection to the external data
source each time it is turned on.

External Data Acquisition Frame

Ch 1-16 Enabled: When checked, the data from that
external channel will be saved in the
header of the SIG file. When unchecked,
that channel will be ignored, and a zero
value will be stored in its place in the SIG
header.

Use these check boxes to tell the software
which of the 16 input channels actually
have a sensor of interest attached to the
external data device.

External Data Display Frame

Display Ch. A-B: These two drop-down menus determine
which (if any) of the 16 external channels
are displayed in the main GUI screen.

When either 1 or 2 channels are
selected for display, the main GUI
screen shows two additional elements
for control and display of the external
data, as described below:

Press the Ext Data Scan button when a new set of external
data samples is desired. No spectral data is acquired when
Ext Data Scan this button is ptessed, and only the Last Scan values (see
below) are updated.

Press the Ext Data Dark button when a new set of external
dark samples is desired. No spectral data is acquired when
Ext Data Dark this button is pressed, and only the Last Scan values (see
below) are updated.

The External Data Display frame displays the data from the

S e ey selected External Data channels:

Bl kRl i 4 Channel: The Channel number for that column.
Diark: 0 il Dark: The most recent Dark Scan values taken. When
Referehice: 1] ] updated, the Reference and Last Scan fields are reset.
Lazt Scar: 0 1] Reference: The most recent Reference Scan values. When
LastScan®:  00% 00 updated, the Last Scan fields are reset.

Last Scan: The most recent values/percentages taken during
either a Target Scan, or an External Data Scan. The
percentage is computed by dividing Last Scan by Reference.
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Adjust Display Values For External Dark Current:
When checked, dark current correction is
applied to the data displayed in the main
GUI When unchecked, dark current
correction is not applied. This control has
no effect on the data saved to the SIG

file header.

Cancel: Dismiss the dialog without saving
changes.

OK: Apply the settings shown in the dialog.

READ MEMORY ...

Reads (downloads) the instrument’s stand-alone scans from the internal
memory into the PC Data Acquisition Software.

File [Control | Tools Window About
Setup Instrument...
Setup Overlap/Matching...
Setup External Data...

( Read Mermaory... )

Timed Scans... '
Setup GPS...
Setup Water Quality Interface. .

Long Term Timer..,

When selected, the Read Memory command displays the following dialog:
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-

& Read Scan Memory -

Fead Scans

Total Scans In Memom 57 [ Edit Scan Tyvpes During Download

First Scan To Download: 1
Last Scan To Download: |—_§;7

Diownload Drata Handling
(" Do Mot Apply Overlap £ Matching Settings During Download
o Apply Current Overlap £ kMatching Settings During Download

Current Settings:
Owerlap: Remove @ 10001867
Matching Type: Radiance @ 1002 - 1006 / MIR-5'wIR Off

Cutput File Information

Folder: |C:\[Diatah

File Bage Name: |Pine_Data

Output File Mame: Format: | BaseMame_swws L]

Diownload Control
Current Ref Scan Mumber:
Downloading Scan Number;

Mewt File Name: |Pine_Data_0000.sig

Eraze All Scans Download Mow
Cahicel

Read Scans Frame This frame allows the user to define
which internal scans are to be
downloaded and controls the destination
folders and file names.

During download, a SIG data file is
created for each target scan A SIG data
file contains the radiance of the target
scan and the radiance of the most recent
reference scan. The memory slots of the
scans are recorded in the file header.

Note that each stored scan, either a
reference or a target, occupies a
sequentially numbered “slot” within the
instrument. A slot number may vary from
0 to 999, and increment as each stand-
alone is acquired in the field.

Total Scans In Memory: Total number of scans currently stored in
the instrument’s internal memory.
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First Scan To Download: First scan to download. The first scan
typically should be a reference scan.

Last Scan To Download: The number of the last scan to download.

Edit Scan Type: If checked, the user is prompted (see
dialog below) to either accept or change
the stored scan type (reference or target)
as each stored scan is downloaded.

scan1 x|
a2 Scantype: Reference Scan

Wiauld vau like to change Scankype ?
Cancel |

Download Data Handling Frame
This frame allows the user to optionally
apply the current overlap and matching
settings to the data as it is downloaded
from the instrument.

Apply, Do Not Apply Ovetlap / Matching Settings Duting Download:
Select the desired radio button regarding
this option. The current settings are
displayed.

Note that it may be desirable to select the
“Do Not Apply” option, and then later
after the downloading is complete, use
the “Tools->SIG File Matching /
Overlap...” tool to post-process the SIG
files. This process preserves the original
downloaded SIG data, allowing it to be
re-processed (if needed) with different
ovetlap / matching parameters.

Output File Information Frame
This frame determines the location of the
downloaded files and the names of the
downloaded files.

Folder: The current destination folder name

File Base Name: The current SIG file base name. As each
target scan is downloaded, a 4-digit
incrementing number may be appended
to this base name. This field only applies
if the “BaseName_xxxx” format is
selected (see below).

Change: Pressing this button will display a
standard file open dialog box, which
allows the user to select a new Folder and
File Base Name.
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Output File Name Format: This pull-down presents two choices
regarding the format of the output SIG
file name:

BaseName xxxx: As each target is
downloaded, the selected File Name Base
is appended to an incrementing 4-digit
number. Each SIG file written will have
this combination of fields as a file name.

yyMMdd HHmm RxxxTxxx: As each
scan is downloaded, the target’s date

(yyMMdd), time (HHmm) and slot
number (Txxx) will be used, along with
the most recently downloaded reference
scan’s slot number (Rxxx), in order to
form the SIG file name. This format
provides a lot of information relating
back to the original scans right in the SIG
files’ names.

Download Control Frame This frame starts the download process
and shows download progress.

Current Ref Scan Number: This box displays the slot number of the
most recently downloaded (the current)
reference scan.

Downloading Scan Number: This box displays the slot number of the
most recently downloaded scan
(reference or target).

Download Now: Clicking this button begins the process of
downloading of data from the
instrument’s internal memory.

When all data are downloaded a summary
message box indicates that the operation
is complete.

Erase All Scans: Pressing this button permanently erases
all scans within the instrument’s internal
memory. Scans should only be erased
when the user is sure that they are no
longer needed.

Cancel During download, this button stops the
downloading process. During idle times,
this button is used to dismiss the Read
Scan Memory dialog.

TIMED SCANS ...

Acquire spectral data automatically using a scan timer. The user may select the
type of scan (reference vs. target), how the acquired data is displayed, and
whether the data is written to disk files.
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File [Control | Tools Window About
Setup Instrument...
Setup Overlap/Matching...
Setup External Data..,
Read Mermaory...

( Timed Scans... )

Setup GPS...
Setup Water Quality Interface...

Long Term Timer..,

When selected, the Timed Scans display the following dialog:

Timed Scans

—Scan Settings

—Scan Types
("
(;. A o
" Alternate

—Scan Dizplay
+ Single Graph
" Multi Graph
" Mo Graph

¥ Save Tamget Scan Data

= Timing

Bebween Scans: ||:||:|:15 =
Until Mext Searn: IDEI:EIEI

Start | LCancel |

Scan Settings Frame This frame determines the characteristics
of the timed scan.

Scan Type: Reference This option causes reference scans to be
taken on a timed basis. Reference scans
are always displayed in Single Graph
format.

Scan Type: Target This option causes target scans to be
taken on a timed basis. Target scans may
be displayed in either Single Graph or
Multi Graph format.

Scan Type: Alternate This option causes scans to alternate
between Reference and Target on a timed
basis.

Scan Display: Single Graph Target scans are displayed one at a time
in a Single Graph display.
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Scan Display: Multi Graph Target scans are displayed together in a
Multi Graph display format. Scans will
stop being acquired, and a warning
message displayed, if the maximum
number of allowed Multi Graph data sets
(24) is reached.

Scan Display: None Acquired scan data is not displayed.

Save Target Scan Data When checked, target scans cause a new
data file to be written to disk. Otherwise
the scan data is discarded.

Timing Frame This frame controls scan timing.

Between Scans Allows the user to set the time (minutes /

seconds) between acquired scans. The
time can range between 0 seconds and 1

hout.

Until Next Scan When running, this box displays the time
until the next scan is scheduled to be
triggered.

Start Pressing this button begins timed scan

acquisition using the settings shown. This
button changes to “Stop” when the timer
is running and may be used to stop timed
scan acquisition.

Cancel Dismisses the Timed Scans dialog.

SETUP GPS. ...

Set the parameters that allow the Data Acquisition Software to access a source
of NMEA V2.1 GPS data from a COM port.

File [Control | Tools Window About
Setup Instrument...
Setup Overlap/Matching...
Setup External Data...
Read Mermary...
Timed Scans...

(  Setupaps.. )
Setup Water Quality Interface. .

Long Term Timer..,

When selected, the Setup GPS menu item displays the following dialog:
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- Setup GPS %]

—GFS Port Control

Thig contol may be used to access an MMEA compliant GRS zource that is
available via a COM port that iz local tothiz PC. IF uzed. this local GRS data
source will override the GPS data that is sent from the instrument.

COK P
{+ Ligt Only Configured Ports L)
 List All Possible Ports [comts =]
Baud Rate Farity [rata Bitz Stop Bits

| 4300 | [More x| |s = | |
Discor‘-ﬂactl Connect |

I Reconnect To GRS Automatically £t Program S tartup

— Current GPS Data £ Statuz

Lat: I Status; I
Lot I tode: I
Date; I Sateliites In Use I
Tirne:; I Sateliites In View: I

HODOP

NOTE: This dialog is used only to setup a GPS source that is internal to the
acquisition PC or laptop. If enabled by this setup dialog, the data from this
PC/Laptop soutce will overtide the GPS that is provided by the instrument’s
internal GPS source.

GPS Port Control Frame This frame determines the COM port
settings of the GPS data source that is
installed in the computer.

List Only Configured Ports When selected, only ports that are
physically configured into the host
computer are listed in the COM Port
control. The list of configured ports is
built only once each time the Data
Acquisition Program is run.

List All Possible Ports When selected, all 255 ports are listed in
the COM Port control. Use this option if
a virtual port (usually a Bluetooth port)
that you want to use is not present in the
“configured” list above.

COM Port Determines the COM port number for
the NMEA V2.1 GPS data..

Baud Rate /

Parity /

Data Bits /

SVC XHR-1024i /| HR-1024i /| HR-768i / HR-640i / HR-768si / HR-512i USER MANUAL REV 1.13



SPECTRORADIOMETER 36

Stop Bits These controls determine the exact
communication settings when receiving

GPS data.

Reconnect To GPS Automatically At Startup
Checking this option will cause the Data
Acquisition Software to reconnect at
program start, using the current COM
Port settings.

Connect Button /
Disconnect Button Enables/Disables the connection to the
GPS soutce.

Current GPS Data / Status Frame
When connected, displays the current
GPS location, date, time, and status
information.

Lat/Lon/Date/Time/HDOP These fields contains valid GPS data
when a sufficient number of GPS
satellites are available to produce a valid
fix; otherwise, these fields are blank.

Satellites In View /

Satellites In Use Tracks the number of satellites in view of
the receiver, and the number being used
to produce a location fix. At least 3
satellites are required to produce a 2D

fix.

Status The current COM Port connection
status.

Mode The current mode of operation, from

“No Fix” to “3D Fix”.
SETUP WATER QUALITY INTERFACE ...

Set the parameters that allow the Data Acquisition Software to access water
quality data from a Eureka Manta 2 Water Probe.

File [Control | Tools Window About
Setup Instrument...
Setup Overlap/Matching...
Setup External Data...
Read Mermary...
Timed Scans...
Setup GPS...

(_ Setup Water Quality Interface. . )

Long Term Timer..,
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Setup Water Quality Probe Interface .

When selected, the Setup Water Quality Interface menu item displays the
following dialog:

W ater Duality Probe Port Contral

€= Ligt Orily Corfiotred Fats
€ Lt & Fossible Parts

Dizconnect |

COM Port

ICI:\M3| vI

Eorinect |

I~ Reconnect To Probe Automatically At Program Startup

within

Probe Cammurication Status: [T [Receiving Frobe Data 0K

the 515 data file.

"CDM Part Communication Settings

SE\Delau\lsl [1men =] fwore & s = [ =

This contol may be used to receive water qualty data iom a Eureka Manta 2 Water Probe, The probe must be connected via a COM port that is local to this PC. \when
connected, the water quality data values will appear in the "extemal data setl" figld within the SIG data files. The water quality data headsr labels will appear in the "'camm' fisld

Baud Rate

Paiity

Data Bits Stop Bits

Temp_deg_C pH_units SpCond_uS/cm Chl_ug/ HDO_mg/| ‘ HDO_%5at | pH_mt

2330 081 [y 187 873 1058

2330 | -0.34 oo 0183 873 1059 43043

2330 | 0.on 0o 0180 a7 106.9 #1662

2330 955 i) 0173 a7 10549 -139.48

2330 | 923 oo 0.000 000 0.0 -120.55

oK

This control gathers water quality data in real-time from an attached Eureka
model Manta 2 Water Quality Probe. Water quality data is then reported in the
SIG file header information.
See the document “SVC iSeries Spectroradiometer, Water Quality
Measurement System, User Manual” for complete details on use of this option.

Eile | Control | Tools Window About

Setup a special timer that is capable of acquiring data periodically over multiple

days.

Note that a maximum of 10,000 SIG files may be acquired through use of the
long term timer. This limitation comes from the 4-digit (0000 through 9999)

file number appended automatically to each SIG file base name during timed
acquisition.

Setup Instrurnent...

Setup Overlap/Matching...
Setup External Data...

Read Memaory...

Timed Scans...

Setup GPS..

Setup Water Quality Interface..,

( Long Term Timer...

When selected, the Long Term Timer menu item displays the following dialog:
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Long Term Timer

scan data will be d. according to the zel

and Interval bet fcan acqui

Acquisition Sctive Days

Start Date: | 2132017 -

Draily Acquisition Settings

Use this tool to automatically acquire scan data. Scan data will be acquired
from the specified Start Date to the specified End Date [inclusive]. During
each active day. up to 8 active time periods may be zpecified. during which
i i ted Start Time. End Time,

End Date: | 2//2017 -

Save Settings To File |

Period Enabled Start Time End Time Interval
1 i [1z0000 == |ota000 [ot:00 =
2 v [0200:00 = |0300:00 0030 =
3 I [ooooon = [ooooo0 = [on00 =
4 I [omooon = [omoooo = [on00 =
5 I |ooomoo = [ooonoo = (0000 =
B m |ooomo0 = [ooooo0 = [00:00 =
7 I [oooo00 = [omoooo = [ooo0 =
8 I [oo0o00 = [omoooo = o000 =

Fead Settings From File |

Acquigition Contral

Current Date / Time: 2/13/2017 156:13:42

START Timed Take & Reference Scan Mow |
Talge! _S_can
Acquisition Take A Target Scan Mow |

W lgnare Scan Warnings

Hide Settings
Cancel

Use the following controls and fields to setup a multi-day timer.

Acquisition Active Days Frame

Start / End Date

Daily Acquisition Settings Frame

Enabled

Start / End Time

Interval

Save / Read Settings To / From File

This frame determines the range of dates
to acquire spectral data.

These two dates define the first and last
calendar days to include in the data
acquisition.

This frame defines periods within each
active day for spectral data acquisition.
Up to 8 unique periods may be defined.

Each of the 8 periods may be enabled or
disable by use of this check box.

These two times define the beginning and
ending times for each period. Format is
hh:mm:ss (24-hout time format).

This is the time between target scan
acquisitions for each period; format is
mmss.

These two buttons allow you to save /
read daily acquisition settings to / from a
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file. When pressed, you will be prompted
for the file name to use.

Acquisition Control Frame Controls both timed and immediate
spectral data acquisition.

START/END Timed Target Scan Acquisition
This button starts (or stops) timed
spectral data acquisition as currently
defined by the current start/end dates
and time periods.

Take A Reference / Target Scan Now
Pressing these button will cause
immediate acquisition of either a
reference or target scan.

Hide / Show Settings Pressing this button will shrink / expand
the Long Term Timer dialog box; this is
useful to see graphs in the main window
during timed acquisition.

Ignore Scan Warnings Checking this box will cause the software
to ignore warning that would normally
cause time acquisition to halt.
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Tools Menu

The Tools item provides a menu of useful tools for manipulating spectral data, or examining the
instrument calibration tables.

SIG FILE MERGE...

File Control Window About

Merges multiple SIG files into a single comma-delimited text data file, suitable
for import into Excel or other analysis packages. Use this tool to save time
when using a third-party analysis tool to examine multiple SIG files
simultaneously.

(

SIG File Merge...

SIG File Overlap/Matching...
White Plate Reflectance...
Resarnple Spectral Data...

Instrurment Calibration Data...

Remote Access Server...
ENVI Spectral Library...
SIG File Wavelengths..,

#.51G File Merge Tool x|

This tool merges up to 50 51G format input files into a single output file. The output
file format iz either a comma-delimted data file [zuitable for import into Excel). or a

516G

When “SIG File Merge...” is selected, the software presents the following
dialog box.

format file containing the average of all the input data files.

—Merge 516 Files

Step 1: Select the S1G files to merge

‘Browse” button.
Browse...

uging the "

Step 2: Select the format of the
merged data file.

List of S5IG Format Input Files To Merge

C5¥Y format output files contain ALL
input file data in adjacent columns,
plus an extra set of columns
containing averages for all scans.

51G Format Output Files will contain
just the average values of the input
file data.

Step 3: Use the "Process All Files™
button to create the merged data file:
you will be prompted for the output

file name.

(~Merged Format-

(= CSY Formiat [Excel] Dutput File
(" SIG Formnat Dutput File
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List Of SIG Format Input Files:

Merge Format:

Process All Files

SIG FILE OVERLAP/MATCHING...

Use the Browse button to select the SIG
format files to merge.

Determines whether the individual SIG
files will be merged into a Comma
Separated Values (CSV) suitable for
import into MS Excel, or into a single
SIG output file.

When CSV Format is chosen, the

individual SIG files appear side-by-side

(across columns) in the output CSV file.

In addition, another set of columns is

added, in the rightmost columns,

containing:

*  The wavelengths

*  The average of all Reference
columns

*  The average of all Target columns

* A calculated Reflectance, that is the
average Target divided by the
average Reference

When SIG Format is chosen, the

resulting SIG file contains:

*  The wavelengths

*  The average of all Reference
columns

*  The average of all Target columns

* A calculated Reflectance, that is the
average Target divided by the
average Reference

Begin processing the SIG files; the user is
prompted for the single output file name
for the merged data.

Applies the current overlap and matching settings to a set of input SIG format
files; note that this option is not available in the SVC HR-512i software.

File Control | Tools _‘.ﬂ_ﬂndow About
SIG File Merge...
(  SIG File Overlap/Matching... )
White Plate Reflectance..,

Resarnple Spectral Data...
Instrurnent Calibration Data...
Remote Access Server...

ENVI Spectral Library...

SIG File Wavelengths..,
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SIG data files that are acquired by the PDA Software do not have overlapping
data removed, and have not had any matching algorithm applied. Use this tool
to remove overlap and possibly apply detector matching algorithms.

Note that it is NOT necessary to use this tool on SIG file data acquired
directly by the PC Data Acquisition Software; it is also NOT necessary
to use this tool on SIG file data that was downloaded from the
instrument’s internal memory. In both cases, the current matching/overlap
settings may have already been applied when the scans were

acquired/downloaded.

When “SIG File Ovetlap/Matching...” is selected, the software presents the following dialog box:

#-5can Matching/Overlap Correction

Thizg tool applies the current M atching/Overlap zettings to a list of 51G
format files. It may be uzed to apply theze settings to any scans that

have been acquired by the PDA zoftware.

—Apply Matching/Overlap to SI1G Files

List of SIG Format Input Files To Process:

Step 1: Select the 516G files to
process using the "Browse" button.

Step 2: Use the "Process All Files"
button. The comections are applied to
each 51G file in turn, and a new
comrected 51G output file [with the
string ”_moc™ appended to the
original name] is created.

. Process Al Files

Browse... |

0K |

List Of SIG Format Input Files:

Process All Files

WHITE PLATE REFLECTANCE...

Use the Browse button to select the SIG
format input files to process.

Begin processing the SIG files; each SIG
file in turn is read and processed, and the
modified data is written to an output file
with the string “_moc” (Matching
Ovetlay Correction) appended to the
original name.

For example, if the input SIG file name
is: “gr0626006.sig”, then the output SIG
file name is: “gr062606_moc..sig”

Corrects for non-ideal white (reference) plate reflectance.
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File Control | Tools __".“_ﬁndow About
SIG File Merge...
SIG File Overlap/Matching...
( White Plate Reflectance,., _)
Resarnple Spectral Data...

Instrurnent Calibration Data...
Remote Access Server...

ENVI Spectral Library...

SIG File Wavelengths..,

When “White Plate Reflectance...” is selected, the software presents the
following dialog box:

- White Plate Reflectance Correction x|

This tool applies a correction for actual White Plate reflectance to a list
of acquired S1G format data files.

- Correct Acquired Scans For Wwhite Plate Reflectance

Step 1: Select the White Plate ‘white Plate Reflectance [Data File:

Reflectance Data File uzing the I|
"Browse" button.

Browse...

List of §1G Format Files To Process:

Step 2: Select the 51G files to A
process using the "Browse" button.

[l

Step 3: Usze the "Process All Files"
button. The comrections are applied to
each 516G file in turn, and a new p AlEl
comected 51G output file [with the [Pha e
string "_wpc" appended to the
original name] iz created.

0K |

White Plate Reflectance Data File:  Use the Browse button to select the
calibration file that corresponds to the
white plate used to take the SIG file
reference data. The White Plate
Reflectance Data Files is a two-column
text file. The first column is a list of
wavelengths (in nm), and the second
column is the actual white plate
reflectance at that wavelength. See
Appendix B — File Descriptions for a
description of this file).

List Of SIG Format Input Files: Use the Browse button to select the SIG
format input files to process.

Process All Files Begin processing the SIG files; each SIG
file in turn is read and processed, and the
modified data is written to an output file
with the string “_wpc” (White Plate
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Correction) appended to the original
name.

For example, if the input SIG file name
is: “gr0626006.sig”, then the output SIG
file name is: “gr062606_wpc..sig”

RESAMPLE SPECTRAL DATA...

Resample the input SIG format data files, and write the resampled data to new
output SIG format data files.

File Control | Tools __".“_ﬁndow About
SIG File Merge...
SIG File Overlap/Matching...
White Plate Reflectance..,

( Resarnple Spectral Data... j
Instrurment Calibration Data... .

Remote Access Server...
ENVI Spectral Library...
SIG File Wavelengths..,

When “Resample Spectral Data...” is selected, the software presents the
following dialog box:

#-Resample Spectral Data 1[

This tool re-samples acquired 516G file data using linear interpolation. and
writez the resampled data to a new S1G output file.

Mote that the rezampling process may produce an ouput file with more
than 1024 data points. The HR-1024 Data Acquition Software input
routines are currently limited to files with 1024 or less data points.

—Resample Spectral Data

i~ Resampling F ange [nm]
£+ ze &l Wavelengths

Step 1: Select the input SIG file C UseThisReange: M [3s0 = Max s =
wavelength range and rezampling
inteiv ot Reszampling Interval [rm]: |1 :'-1

List of SIG Fomat Files To Process:

Step 2: Select the 51G files to
process uging the "Browse" button. Browse. . |

Step 3: Use the "Process All Files™

button. Each input 51G file is
re-sampled. and a new 51G output file P ANE
[with the slripg *_resamp” appended s e

to the original name] is created.
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Resampling Range Select either all wavelengths present
within the input SIG file, or a specific
range of interest.

Resampling Interval The interval used to perform the
resample process.

List Of SIG Format Input Files: Use the Browse button to select the SIG
format input files to process.

Process All Files Begin processing the SIG files; each SIG
file in turn is read and is linearly re-
sampled at the specified Resampling
Interval, and the modified data is written
to an output file with the string
“_resamp”’ appended to the original
name.

For example, if the input SIG file name
is: “gr0626006.sig”, then the output SIG
file name is: “gr062606_resamp..sig”

INSTRUMENT CALIBRATION DATA...

Read, display, and save the calibration and other configuration data stored
within the instrument.

File Control | Tools __".“_ﬁndow About
SIG File Merge...
SIG File Overlap/Matching...
White Plate Reflectance..,
Resarnple Spectral Data...
( Instrurnent Calibration Data... j

Remote Access Server...
ENVI Spectral Library...
SIG File Wavelengths..,

All instrument calibration information resides in non-volatile memory within
the instrument. The Instrument Calibration Tool allows the operator to:
*  View the connected instrument’s calibration tables.

e Write the instrument’s current calibration tables to files on the
PC’s hard disk.

When “Instrument Calibration Data...” is selected, the software presents the
following 3-tabbed dialog box. Each tab on the dialog box allows the operator
to view different information about the currently connected instrument.

Note that the information within these tabs will be blank if no instrument is
currently connected (See the Control->Setup Instrument menu to connect to
an instrument).
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- Instrument Calibration Data Tool x|
Thisz tool displays the length and radi tric calibration values of
the cumrently connected instrument. It also allows you to read/write those
values from digk files, and to update the inst I’z calibration values.
T ‘wiavelength Calibration T Radiometnic Calibrations
rodel: !HH
Serial Number; luf,gnm
Pragram Revision: Iz_[i]
Protocol Revision: I] A0
‘wiite Instrument [nfarmation Ta
File
0K |
Instrument Information Tab: This tab simply displays the instrument’s
model and embedded firmware

information.

Write Instrument Information To File:
The program will prompt the operator to
save the displayed information to the
PC’s hard disk.

SVC XHR-1024i /| HR-1024i /| HR-768i / HR-640i / HR-768si / HR-512i USER MANUAL REV 1.13



SPECTRORADIOMETER 47

#:Instrument Calibration Data Tool ll
This tool dizplays the wavelength and radiometric calibration values of
the cumrently connected instrument. It also allows you to read/write those
values from disk files_
Instrument Information T ]/ Radiometric Calibrations
Calibration Date [mmddyy): !100412
‘Wavelength Calibration Table [sx=.x): [Band |Wvlen ‘j
1 mms] |
2 3388
3 3412
4 27
] 3441
s s w/rike W/ avelength Calibrati
2 2474 rite "/ avelength Calibration
g S4EE Table Ta File
3l Fiead Ww/avelength Calibrati
10 5 ead W avelength Calibration
1 10 Table From File
12 3545
13 Alnispe]
14 3574
15 ] “wiite 'wavelength Calibration
15 03 TableTo Instrument
17 361.8 L‘
Set Inztrument Calibration aK
Paszword

Wavelength Calibration Tab: This tab displays the wavelength
associated with each of the instrument’s
1024-band wavelength calibration table.
The date of the instrument’s last
calibration is also displayed in the
“Calibration Date” text box.

Each button on this tab is described
below:

Write Wavelength Calibration Table To File:
The program will prompt the operator to
save the wavelength calibration table to
the PC’s hard disk. The actual calibration
table within the instrument is not
changed by this operation.

Read Wavelength Calibration Table From File:
The program will prompt the operator
for a file name on the PC’s hard disk that
contains a wavelength calibration table,
and display that information. The actual
calibration table within the instrument is
not changed by this operation.

Write Wavelength Calibration Table To Instrument:
The program will prompt the operator to
upload the current wavelength calibration
table to the connected instrument.
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Note that this button will only appear if
a) the wave cal file was just read in from
disk, and b) the wave cal file has the
correct corresponding “key” file
associated with the “cal” file. Contact
Spectra Vista for further information.

strument Calibration Data Tool ll
This tool dizplays the wavelength and radiometric calibration values of
the cumrently connected instrument. It also allows you to read/write those
values from disk files_
Instrument Information T Wwavelength Calibration T
Select Optic Humber [1-8]: |1 vI
Dptic Name [6 chars max): ILENS 4
OptizType: [RaDIANCE 7
Radiometiic Calibration Table: [g3n4 |Wvlen | Factar | Aj
i 3383 2.7460000E-04 _J
2 3398 2.9720000E-04
5 3.2 3.1640000E-04
4 27 3.2260000E-04
i 3441 3.3390000E-04
B 2458 2.5020000E-04 eI
7 2471 3.6000000E-04 IRt e
g MEE = 5370000E-04 Calibration Table Ta File
3 3500 3.7240000E-04 =R
10 Al 3.7490000E-04 S e LEnIpE e
1 Eig = 6720000E-04 Calibration T able From File
12 3545 2.5E00000E-04
13 HRhg 3.5030000E-04
14 3574 2.4150000E-04 : : 7
15 3589 317BO0DDE-04 SO
15 2603 5 QENONE-04 Calibration Table Tao Instrurment
17 361.8 2.8850000E-U4L‘
Set Inztrument Calibration aK
Paszword
Radiometric Calibration Tab: There are up to 8 radiometric calibration

tables (corresponding to up to 8 optional
instrument fore-optics) stored within the
instrument.

This tab displays each of these eight
1024-entry tables, one table at a time. The
table that is currently displayed may be
selected via the “Select Optic Number”
control at the top of the tab. Note that
buttons that are used to read or write
radiometric data only operate on a
single table at a time — the table
currently selected by the “Select Optic
Number” control.

Each fore-optic’s radiance calibration
information has an “Optic Name”,
which is a 6-character familiar name that
is displayed on the instrument’s LCD.

Each fore-optic calibration also has an
“Optic Type” — the radiometric
calibration data is either a “Radiance”
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mapping, a “RAW” (DN) mapping, or an
“Irradiance” mapping.

Each button on this tab is described
below:

Write One Radiometric Calibration Table To File:
The program will prompt the operator to
save the currently selected (1-8)
radiometric calibration table to the PC’s
hard disk. The actual calibration table
within the instrument is not changed by
this operation.

Read One Radiometric Calibration Table From File:
The program will prompt the operator
for a file name on the PC’s hard disk that
contains a single radiometric calibration
table, read that table into the currently
selected table (1-8), and display that
information. The actual calibration table
within the instrument is not changed by
this operation.

Write One Radiometric Calibration Table To Instrument:
The program will prompt the operator to
upload the currently selected calibration
table to the connected instrument.

Note that this button will only appear if
a) the radiance cal file was just read in
from disk, and b) the radiance cal file has
the correct corresponding “key” file
associated with the “cal” file. Contact
Spectra Vista for further information.

REMOTE ACCESS SERVER...

Allow remote network access to the instrument’s control and data, using a
TCP/IP client/server interface.

File Control | Tools _"."'_."lndow About
SIG File Merge...
SIG File Overlap/Matching...
White Plate Reflectance..,
Resarnple Spectral Data...
Instrurnent Calibration Data...
( Remote Access Server... )
ENVI Spectral Library...
SIG File Wavelengths..,
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By using this tool, the PC Data Acquisition program becomes a network server
that allows access from remote clients via a simple TCP/IP based protocol.

See Appendix H — Instrument Remote Access, for a description of the
network protocol used to remotely access the instrument.

emote Access Server Tool _£|

This tool listens for TCP/IP network co ti and p HR-1024 scan
commands/spectral data to/from the remote client. It is used to remotely access
the HR-1024 via a TCP/IP connection.

~Remote Accoess To HR-1024

Step 1: If not already connected to
the HR-1024 on the local COM port, HF-1024 Status: I Nt Corractad i |
press the “"Connect..." button to
establish a COM connection to the
HR-1024.

¥ Dizable GUI Scan ' amings During Remote Access

Step 2: Press the "Listen For Remote Local IP Address: Il‘j? 168.1.101
Connections™ button in order to allow Lacal Part Mumber: [go00

a network client to access the
HR-1024. The Remote Access Tool
will listen for connections from Listen For Bemate |
network clients at the Local IP Connections
Address and Port Humber shown.

Cannection Status; l Mot Listening For Connections
Cancel |
Connect...: If the PC Data Acquisition program is

not already connected to the instrument
(via serial port, USB, or Bluetooth), use
this button to bring up the standard
Control/Setup menu to create that
connection.

If already connected, this button will be
disabled.

Disable GUI Scan Warnings...  Checking this box will prevent the
appearance of “normal” GUI scan
warnings from stopping instrument
remote access.

Listen For Remote Connections: Pressing this button causes the PC Data
Acquisition program to act as a server,
located on the network at the displayed
IP Address and Port Number.

If already listening, this button will be
disabled.

Close Remote Connections: Pressing this button causes the PC Data
Acquisition program to close down its
server function and stop listening for
client connections.

If not listening, this button will be
disabled.
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ENVI SPECTRAL LIBRARY...

Used to create ENVI compatible Spectral Libraries from SIG format data files.

File Control | Tools _"."'_."lndow About
SIG File Merge...
SIG File Overlap/Matching...
White Plate Reflectance..,
Resarnple Spectral Data...
Instrurnent Calibration Data...
Remote Access Server...

c ENVI Spectral Library... J

SIG File Wavelengths..,

This tool reads SIG format files from disk and combines them into am ENVI
Spectral Library.

The Spectral Library can be created from the SIG files’ reflectance, target, or
reference data. Each SIG file can optionally be associated with a familiar
“ENVI Spectra Name”, which is included within the ENVI Spectral Library.

Note that since ENVI Spectral Libraries only support a single wavelength
table, all SIG format files selected for inclusion into a library must have
identical wavelength tables. So, for example, SIG files with overlap
preserved cannot be combined with SIG files with overlap removed within a
single ENVI Spectral Library.

When “ENVI Spectral Library...” is selected, the software presents the
following dialog box:
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#-51G File ENYI Spectral Library Tool ﬁ

This tool creates an ENYI Spectral Library from S1G format files. A maximum of 256
516G files may be included in the library. The 51G data file can contain a maximum of
1024 data points. In addition. all 51G files must have the same wavelength vector.

— Create EMVI Spectral Library

Step 1: Select the 51G files to include in the spectral library T |
uzing the “"Browse" button.

515 File Narme | ENVI Spectia Name «|

=]

Step 2: If needed. click / edit the "ENY| Specta Hame" field above to describe each
spectra; otherwise, the "51G File Name" field itself will be used for the Spectra Name.

Step 3: Select which data from the
516G file to include in the spectral |F|ef|ectance 'I
library.

5tep 4: Enter the Spectral Library -
desciption. IENVI Spectral Library

Step 5: Use the "Create Library™
button to create the ENYI Spectial Create Lib
Library file; you will be prompted for H e

the output file name.

|

Browse: Pressing this button presents the normal
“File Open” selection dialog, which is
used to select the SIG format files that
will be included in the Spectral Library.

Once selected, the SIG files are listed in
the “SIG File Name” column of the text
grid.

A descriptive name for the spectra found
in each SIG file may optionally be
entered by clicking on the corresponding
box in the “ENVI Spectra Name”
column and typing a descriptive name.

If no “ENVI Spectra Name” is entered,
then the “SIG File Name” will be used to
name the spectra within the ENVI
Spectral Library.

SIG File Data: Selects whether the reflectance, target, or
reference data columns from the SIG file
is used to create the ENVI Spectral
Library.

Spectral Library Description: Enter the ENVI Spectral Library
description into this box. This name will
become the name of the Spectral Library
within the ENVI application.
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Create Library: Pressing this button causes the software
to create the ENVI Spectral Library
header and data files.

OK: Pressing this button dismisses the dialog
and returns control backto the main
window.

SIG FILE WAVELENGTHS...

This tool may be used to insert a new wavelength vector into a set of existing
SIG files.

File Control | Tools | Window About
SIG File Merge...
SIG File Overlap/Matching...
White Plate Reflectance...
Resample Spectral Data...
Instrurment Calibration Data...
Remote Access Server...

ENVI Spectral Library...

(  SIGFile Wavelengths... )

When “SIG File Wavelengths...” is selected, the software presents the
following dialog box:

& SIG File Wavelength Tool

This tool substitutes a new wavelength table into existing 51G format files.

Insert New wavelengths 516G Files
5tep 1: Select the wavelength file that was Brghaltiavenah i
in uze when the input 51G data file was | Browse...
acquired.

Mew 'Wavelength File:

Step 2: Select the new wavelength file. | Browse...

I

List of SIG Farmat Input Files To Process:

Step 3: Select the 51G files to process using B
the “Browse" button. TOWgE...

Step 4: Select which spectrometers will be
subject to new wavelengths. W WISMIR W SwWiR W SWIRZ
If checked. use new wavelengths:
If un-checked, keep original wavelengths.

Step 5: Use the "Process All Files™ button.
The new length table is applied to each
516G file in turn. and a new S1G output file
[with the gtring _wvI|" appended to the
original name] is created.
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Original Wavelength File This is the wavelength calibration file that
was installed in the instrument at the time
that the SIG files were acquired.

New Wavelength File This is the wavelength calibration file that
should be substituted in place of the
original wavelength file.

List Of SIG Format Input Files To Process

: Use the Browse button to select the SIG
format input files to process with this
tool.

Spectrometers List Use these check boxes to control which
of the spectrometet’s data within the SIG
files should be subject to the new
wavelengths.

Process All Files Begin processing the SIG files; each SIG
file in turn is read and processed. The
new data containing the new wavelength
vector is written to an output file with the
string “_wvl” appended to the original
name.

For example, if the input SIG file name

is: “test.sig”, then the output SIG file
name is: “test_wvl.sig”.

Window Menu
The Window item provides a menu of available window displays; it allows the operator to switch

back and forth between the two types (Single- and Multi-Graph) displays, and allows the operator
to control some characteristics of the graph (line width, data markers, etc.)

SINGLE GRAPH
Displays the currently selected file in a Single Graph.

File Control Tools | Window | About

( Single Graph _)

Multi Graph

1
v Show Target JPEGs
Plot Settings...

v Larger Buttons

A single measurement’s Reference and the Target Radiance are scaled
against the left Y-axis and the Percent Reflectance (Target/Reference
*100) is scaled against the right Y-axis.

An example of this is shown below:
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. SYC HR-1024 - [Single Graph] =18l

File Contral Tools ‘Window About

Reterence Scan

Target Scan

95428 4—

Dark Scan

89886.5—

TB343 6—

BEEO0.B—

a7257 6—

47714.7—

% Reflectance

38171 B

28628.8—

Radiance {wlem*2inm/fsry*10~{-10}

19085.8—

oo
16943 21971 25000

namne= alunite 4 HR 1024-1001 8-11-06.5ig
R: 0671001

| L 77,120 1214

average: 94,1 47 2291

optic= LENS 3(1), LENS 3{1)

[Ehannel [Wavelenath: [Wale:

The graphs shown in the example above are:
Reference Radiance (Red)
Target Radiance (Yellow)
% Reflectance (Black)

Each of these is displayed as a function of wavelength. The text box in the

lower portion of the window displays the file header information.

MULTI GRAPH

Displays the current list of open files together in one graph. Files can be
displayed as reference radiance, target radiance or percent reflectance.

File Control Tools | Window | About

Single Graph
(v Multi Graph )

v Show Target JPEGs

Plot Settings...

v Larger Buttons

The following is an example of a Multi Graph:
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=lalx

% 8YC HR-1024 - [Multi Graph]
File Contral Tools Window  About

Reterence Scan

Tatget S eat B
Dark Scan H : ! j ] ! : # alunite sig

kaolinite.sig

alunite.sig
laalinite: sig

snil.5ig

% Reflectance

—Flot Types
Refeience
Target k) : ! 5

9857 128868 1591.4 1894.3 21971 25000

[Ehannel [ avelenath: [Walue:

The Multi Graph displays the Target Radiance of the files in the File
Stack versus wavelengths. The Multi Graph can display a maximum
of 24 scans.

SHOW TARGET JPEGS

File Control Tools | Window | About

Single Graph

¥ Multi Graph

(v’ Show Target IPEGs _)
Plot Settings...

v Larger Buttons

When the Show Target JPEGs option is checked, the target photo
associated with a scan (if it exists) will be displayed along the target’s

spectral data.

In order to be displayed, the target photo must have the same file
name as the target SIG file, with the extension “.jpg” appended. For
example, if the target SIG file is named “jarosite.sig”, then the
associated target photo must have the name “jarosite.sig.jpg” in order
to be automatically displayed.
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The target photo will be displayed any time the target SIG file is
displayed in Single Graph Mode, i.e., when the target SIG file is
double-clicked in the file stack.

PLOT SETTINGS ...

Configures the default X-axis, line width, and marker usage. You may
also use this menu to exclude certain areas of the plot — for example, to
exclude water absorption areas of the plot.

File Control Tools | Window | About
| Single Graph
Multi Graph

Show Target IPEGs

( Plot Settings... )

v Larger Buttons

When Plot Settings is selected, the following dialog appears:

«#Plot Dptions ] EH

— ¥ awiz - Wavelenath Contral
Min ' avelength [nm): l35|j Max wavelength [nm]: |2500

— Graphing Options
Line 'width 13 - I I Use Markers

I~ DontPlotData  From I?Gg mm. To I??n i
I~ DontPlotData  From I;gu[_\. rmTo Iggg[_\. fim

I~ DontPlotData  From [350  fom To Img[_\. fim

I~ DortPlotData  From !;’-]DU rmTo |11|j|[_‘. fim

Apply Mow | oK |

X-Axis — Wavelength Control Frame
Controls the default extent of the X-Axis of the plot.

Min Wavelength = Sets the default minimum X-axis wavelength to use when
displaying spectral data.

Max Wavelength Sets the default maximum X-axis wavelength to used when
displaying spectral data.

Graphing Options Frame
Controls several feature of the plot itself.

Line Width Sets the relative width of the line used to graph spectral
data.

Use Markers If checked, each data point plotted is marked by a square
box.

Don’t Plot Data /
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From /

Cancel
Apply Now

OK

If the Don’t Plot Data checkbox is checked, the From / To
text boxes define one area of the plot that will be excluded
from display. The From / To boxes should contain valid
wavelengths (in nanometers). Note that the check boxes
affect only the displayed plot, they do not affect acquired
data stored in SIG files.

Exits this dialog without changing settings.
Applies changes and keeps the dialog open.

Applies changes and exits the dialog.
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LARGER BUTTONS

Increases the size of the Reference, Target, etc. buttons.

File Control Tools About

Single Graph
Multi Graph

Show Target IPEGs

Plot Settings...

(J Larger Buttons )'

When checked, the Larger Buttons option increases the size of the Reference, Target, Dark, and
External Data Scan buttons. This option is useful on tablet PCs with a touch screen, in order to
make it easier to press the on-screen buttons.

About Menu

The About menu item displays a dialog box that provides model, the current serial number, as
well as the PC Data Acquisition Software version. Note that the Instrument Serial Number field
can only be displayed after the PC Data Acquisition Software has successfully connected to an
instrument.

Eile Control Tools Window | About

When About is selected, the following dialog box appears:

#-About HR-1024i ] x|

SYIC HR-1024i PC Diata Acquisition Software
Wersion 1.4.3

Mo Instrument Currently Connected

PROGRAM CHANGE LOG: -~

WERSION 1.4:

- Improved/optimized scan download speed
YERSION 1.3:

- Support for intemnal [PC) GPS devices

- Phota downloading enhancements
YERSION 1.2:

SYC

W -

=

v zpechiavista.com

Spectra Vista Carparation

Note that your software version may be different from this example. The “PROGRAM
CHANGE LOG” contains a list of recent changes to the PC Data Acquisition Software
in reverse chronological order.
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Section 3 — Operation
1. Setup

Battery Pack

To use the instrument, install a fully charged battery pack (see Section 4 — Battery Charger). This is done
by sliding a charged battery pack into the battery slot located on the bottom of the instrument. Push in far
enough to latch it in place. When in position 6 copper contacts on the battery pack come in contact with 6
mating contacts on the bottom of the instrument enabling the battery pack to power the instrument.

Instrument Power-on Time

When initially turned on the instrument displays its model number on the initial LCD screen. During this
initial power-on period the instrument is waiting for the thermal-electric coolers to reach operating
temperature before data collection can begin. This period lasts less than a minute and when complete the
“Ready” light on the control panel comes on.

Instrument Warm-up Time

For optimal performance, the instrument should initially be turned on for a period of approximately 15
minutes prior to first use. During this period, the instrument should be placed in the environment where
scanning will take place. This period allows the detector temperatures and other electronics to stabilize
before taking spectral data.

Instrument Orientation

The instrument should be setup with its cooling slots on the bottom oriented as close as possible to
vertical. Also the bottom of the instrument should be oriented away from the sun in order to maximize
internal heat dissipation.

Laser (Tripod or Hand-held)

A sighting laser is used to aid in aligning the instrument to the target to be measured. The reference or
sample (target) should be placed to completely fill the field of view of the instrument. The sighting laser
can be actuated by pressing the laser scan switch on the top of the instrument.
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Field of View

A field of view diagram is provided with each instrument and shows the relative position of the sighting
laser spot and the active field of view for the instrument at the distance specified on the diagram (normally
1m). If optional entrance optics are included, the corresponding FOV diagrams will also be supplied. (See
Appendix Z for inserted hardcopies of FOV diagrams supplied with your instrument, when applicable).

SIGHTING LASER &

TARGET
DISTANCE

FIELD OF VIEW |

Figure 6 Setup for FOV map

CAUTION: Do NOT look into the sighting laser window or laser beam.
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2. Connecting The Instrument To A Computer
Prior to downloading spectral data stored within the instrument, and prior to using the PC Data

Acquisition Software to directly acquire spectral data, the instrument must first be connected to a (physical
or virtual) port on a Windows PC. This connection can take place in one of two ways:

* By physically connecting the PC’s USB connector to the instrument’s USB-B connector (on
the bottom plate) using a standard USB cable. Installation of special device drivers (supplied
with the instrument) on the Windows PC is required. See Appendix E — PC USB Device
Drivers for installation instructions.

* By creating a Bluetooth “virtual” COM port connection between the computer and the

instrument. This option requires installation of third-party Bluetooth hardware and drivers
(not supplied with the instrument) on the Windows PC.

3. Stand-Alone Data Acquisition
Operation Via The LCD Display

The LCD touch screen display on the control panel allows for stand alone operation of the instrument,
allowing for the acquisition and viewing of spectral data.

The display consists of 3 screens with the following functions:

SCREEN 0 (Power-On Screen): appears for 10 seconds after power-on, and includes:
0 INSTRUMENT MODEL/SERIAL NUMBER
0 FIRMWARE VERSION

0 LAST CALIBRATION DATE
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SCREEN 1 (Main Screen):

SN/ SCAN:| TARGET SETUP

REFERENCE

1445

CAM
OFF

GPS

+039%

vev
E-

EXT
350 1000 1500 2000 2500

0 SETUP BUTTON
Touch SETUP to go to the Screen #2 (Setup Screen A) to change various scan settings.

0 SCAN: BUTTON
Touch SCAN to chose the type of scan (Reference or Target) that will be acquired the
next time the manual trigger button is pressed

0 CURRENT SETTINGS / STATUS AREAS — shows cutrent instrument operating mode and
status:
=  BAT - Battery level — 0 to 100%
=  MEM - Most recent internal scan memory slot used — 000 (empty), 001 through 999.
= GPS - The current GPS receiver mode/status:

OFF Turned off.
N/L Turned on, but no position information is available.
OK Turned on, position valid.

=  CAM - Current internal JPEG camera mode:

OFF Turned off.
N/S Turned on, but no sync with the camera.
LO Target JPEGs will be acquired in low-resolution.
HI Target JPEGs will be acquired in high-resolution.
= EXT — The current External Data interface mode/status:
OFF Turned off.
N/C Turned on, but no Bluetooth connection established.
N/S Turned on, Bluetooth connected, but no valid data.
REF Valid data is being received, awaiting a reference scan; a

reference scan will establish the baseline for calculating
percent change in the currently selected external data
channel.

XX% Valid data is being received, and we’ve acquired Reference
data. This field is now displaying the percent change in
the currently selected external data channel when
compared to the reference, in the range -99% to +99%.
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0 LAST ACQUIRED DATA GRAPH AREA — a small graph showing last acquired scan:
= For a Reference scan — always displays radiance.
=  For a Target scan — displays either radiance or reflectance (depending on settings)
=  Touching any area of the graph cycles you between displaying target radiance and
target reflectance; the graph type that is currently displayed is called out just above the
upper right corner of the graph area.

0 GENERIC STATUS / WARNING / ERROR TEXT LINE - a single line of text at the
bottom of the main screen which displays status, warning and/or error messages.
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SCREEN 2 (Setup Screen A): Controls various instrument settings:

SYC MAIN | NEXT

FOREOPTIC:| LENS 4

TRIGGER: LASER + SCAN

SCANTIME: < 5 >

STORED SCANS: ﬂ 008 ERASE ALL

0 MAIN BUTTON:
Touch MAIN to retutn to Screen #1 (Main Screen).

0 NEXT BUTTON:
Touch NEXT to continue on to Screen #3 (Setup Screen B).

0 FOREOPTIC BUTTON:
Touch FOREOPTIC until the foreoptic that is currently installed on the instrument
appears — 4 degree lens, fiber optic, etc.

0 TRIGGER BUTTON:
Touch TRIGGER to control the action performed when the LASER/SCAN trigger
button is pressed:

LASER ONLY Laser is lit while the trigger is pressed.

LASER + SCAN Laser is lit while the trigger is pressed; in

addition, a stand-alone scan is acquired when

the trigger is released.

SCAN ONLY A stand-alone scan is acquired when the trigger

is released

0 SCANTIME BUTTONS:
Touch the < or > button to decrease or increase the instrument scan time.

0 STORED SCANS BUTTONS:
*  Touch the < button to remove just the most recently acquired stand-alone scan.
*  Touch the ERASE ALL button to permanently remove all internal stored scans; once

this button is pressed, a confirmation button will appear before the scans are actually
removed from memory.
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SCREEN 3 (Setup Screen B): Controls various instrument settings:

SYC MAIN

CAMERA: HI

0 MAIN BUTTON:
Touch MAIN to retutn to Screen #1 (Main Screen).

0 NEXT BUTTON:
Touch NEXT to continue on to Screen #4 (Setup Screen C).

0 CAMERA BUTTON:
Touch CAMERA to cycle among the internal JPEG camera target scan settings:

OFF No photos are taken.

LO Low resolution (320x240) photos are taken with each
Target scan.

HI High resolution (640x480) photos are taken with each
Target scan.
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SCREEN 4 (Setup Screen C): Controls the GPS and displays GPS status:

SYC MAIN

GPS:| ON

SATS LOCKED: 06
LATITUDE: 4140.6736N
LONGITUDE: 07351.2773W
GPS TIME: 170758.397

0 MAIN BUTTON:
Touch MAIN to retutn to Screen #1 (Main Screen).

0 NEXT BUTTON:
Touch NEXT to continue on to Screen #5 (Setup Screen D).

0 GPS BUTTON:
Touch GPS to turn the internal GPS function ON/OFF.

0 GPS STATUS FIELDS:
=  SATS LOCKED: Number of satellites currently being used to compute position.
= LATITUDE/LONGITUDE/GPS TIME: Current position and GPS reported time

stamp; these fields will remain blank until a position solution has been computed.
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SCREEN 5 (Setup Screen D): Controls the External Data Interface functions:

SVC

EXTERN DATA:

BT ADDRESS:
STATUS:

DISPLAY CHAN:
DARK CORR:

TAKE DARK

ON

646E6CCOB62F
CONNECTED, DATA 0K

1
ON

MAIN

[11791]

SAVE SETTINGS

0 MAIN BUTTON:

Touch MAIN to retutn to Screen #1 (Main Screen).

0 NEXT BUTTON:

Touch NEXT to continue on to Screen #6 (Setup Screen E).

0 EXTERN DATA BUTTON:

Touch EXTERN DATA to turn the External Data Interface function ON/OFF.
When turned ON, the instrument will attempt to actively connect via Bluetooth to an

External Data Interface.

0 BT ADDRESS FIELD:

Displays the 12-digit hexadecimal Bluetooth address of the External Data Interface that
is currently configured into the instrument. This address determines the source of
external data acquired by the instrument during spectral scans. This field may only be
changed via the PC Software. See section SETUP EXTERNAL DATA ... for more
information on how to change this field.

0 STATUS FIELD

Displays the current state of the Bluetooth connection between the instrument and the

External Data Interface:

NOT CONNECTED The interface is turned off, or the interface is

turned on but no Bluetooth connection can
be established to the external data source.

CONNECTED, NO SYNC The interface is connected to the external

data source via Bluetooth, but the data
source is not sending correctly formatted
data.

CONNECTED, DATA OK | The interface is connected and receiving

correctly formatted data.

0 DISPLAY CHAN BUTTON

Touch DISPLAY CHAN to select the channel (1 to 8) whose teal-time data values ate
displayed in [BRACKETS] ; this allows the operator to monitor external data values for
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each channel. This is also the channel selected to compute the percent change (Target to
Reference) found in the EXT field on the LCD Main Screen.

0 DARK CORR BUTTON
Touch DARK CORR to turn external data dark correction ON/OFF. When turned
on, the most recent dark values are subtracted prior to computing the percent change
found in the EXT field on the LCD Main Screen.

0 TAKE DARK BUTTON
Touch TAKE DARK in order to store the most recently received set of external data
samples as dark values. The dark values are stored in non-volatile memory. When this
button is pressed, it is assumed that the external sensor has been configured to be in a
“dark” condition. Note that when new dark values are taken, the current set of external
data reference values are invalid; a new reference scan is required before the LCD Main
Screen will begin to show Tatrget/Reference percent change values.

0 SAVE SETTINGS BUTTON
Touch SAVE SETTINGS to save all external data settings to non-volatile memory.
When the instrument is re-powered, the most recently saved settings are restored,
including the most recently acquired dark values.
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SCREEN 6 (Setup Screen E): Controls the AUX port functions; see Appendix K — Aux Port
Specification - for more information about the functions provided by the round AUX port connector
located on the spectrometer’s control panel:

SYC MAIN

AUX FUNCTION: STANDARD

AUX HOST SPD: STANDARD
LOW SPEED DISABELES HOST BLUETOOTH

NOTE: IF AUX PORT SETTINGS ARE
CHANGED/SAVED. CYCLE POWER FOR
THE HEW SETTINGS TO TAKE EFFECT

SAVE SETTINGS

0 MAIN BUTTON:
Touch MAIN to retutn to Screen #1 (Main Screen).

0 AUX FUNCTION BUTTON:
Touch AUX FUNCTION to cycle among the possible uses for the round AUX port
located on the spectrometet’s control panel:

STANDARD | The AUX port’s pins 3 thru 6 are inputs to the
spectrometer’s Trigger function. This is the standard
configuration for these pins — Do Not Change this
setting, it should only be changed for special
purpose applications.

STEPPER The AUX port’s pins 3 thru 6 are configured as outputs
which may control an external device.

0 AUX HOST SPD BUTTON:
Touch AUX HOST SPD to cycle among the possible speeds of the RS-232 host
communications interface which is located on the round AUX port connector.

STANDARD | The RS-232 speed is standard (115200 baud), which is
compatible with the default baud rates used by the PC
Data Acquisition Software and the PDA software.
LOW The RS-232 speed is lowered (9600 baud) for

SPEED applications that may use long communication cables
back to the controlling PC. Note that choosing this

option will disable the instrument’s Bluetooth host
interface.

The PC Data Acquisition Software, by default, uses the
standard 115200 baud connection speed; however, this
may be over-ridden by right-clicking (instead of left-
clicking) the “Connect” button within the software’s
Control->Setup Instrument dialog.
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See the section Control Menu, SETUP
INSTRUMENT... for more information.

0 SAVE SETTINGS BUTTON
Touch SAVE SETTINGS to save all AUX port settings to non-volatile memory. When
the instrument is re-powered, the most recently saved settings are restored.
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Reflectance Measurement Ovetview

A reflectance measurement takes the scan of a reference (white plate) and calculates the ratio of the target
scan to that reference.

If any of the below conditions exist, a new reference measurement should be taken before a series of
target measurements:

*  Beginning of a new set of scans.
*  Any change in the collection optics.
*  The instrument has been idle for an extended period, ot has been turned off.

*  Lighting conditions have changed or are variable.
When in doubt, take a reference measurement.

Taking a REFERENCE Measurement

1. Check that the LED Power Indicator is illuminated, indicating that the power is enabled.

2. On the LCD’s “Setup Screen A”, ensure that the trigger field is set to “Laser + Scan” by pressing
the “TRIGGER:” button until the correct setting appears.

3. On the LCD’s “Main Screen”, ensure that the scan type is set to “Reference” by pressing the
“SCAN:” button until the correct setting appears.

4. Place a reference at the point of measurement making sure to completely fill the field of view of
the instrument. (The optional Spectralon® plate is recommended for this purpose.) This
reference measurement is associated with all succeeding measurements until a new reference
measurement is established.

5. Press and hold the LASER/SCAN button to activate the sighting laser and verify the placement
of the reference plate relative to the laser spot as required to fill the field of view.

6. Release the LASER/SCAN button to record the measurement. The MEM field on the LCD’s
Main Screen increments to display the memory slot of the scan that was just acquired.

Taking a TARGET Measurement

1. Check that the LED Power Indicator is illuminated indicating that the power is enabled.

2. On the LCD’s “Setup Screen A”, ensure that the trigger field is set to “Laser + Scan” by pressing
the “TRIGGER:” button until the correct setting appears.

3. On the LCD’s “Main Screen”, ensure that the scan type is set to “Target” by pressing the
“SCAN:” button until the correct setting appear.

4. Place the target material at the point of measurement, making sure to completely fill the field-of-
view of the instrument.

5. Press and hold the LASER/SCAN button to activate the sighting laser and verify the placement
of the target to be measured relative to the laser spot as required to fill the field of view.
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6. Release the LASER/SCAN button to record the measurement. The MEM field on the LCD’s
Main Screen increments to display the memory slot of the scan that was just acquired.

Additional target measurements may be made by pressing and releasing the LASER/SCAN
switch.

Downloading Stand-alone Measurements

To view and analyze the data acquired in stand-alone mode, the data must be downloaded from the
memory of the instrument to a computer running the Windows PC operating system. In order to
download data, the PC Data Acquisition Software must be installed on the Windows PC (See Section 2 —
PC Data Acquisition Software — INSTALLATION for instructions on how to install this software).

Downloading also requires a connection between the instrument and the PC; see the sub-section above “2.
Connecting The Instrument To A Computer” in order to establish this connection.

Once the instrument/PC connection is established, refer to the following sub-sections in Section 2 — PC
Data Acquisition Software in order to download the stand-alone measurements to the PC:

*  See “Control->Setup Instrument...” for basic software connection instructions.

*  See “Control->Setup Ovetlap/Matching...” for instructions on how to configure these
settings, as they are applied to both downloaded and newly acquired spectral data.

*  See “Control->Read Memory...” for downloading instructions.

4. PC Data Acquisition
The same general rules regarding Reference and Target measurement acquisition (described above in sub-
section 3. Stand-Alone Data Acquisition) apply when acquiring data using the PC Data Acquisition

software. Please read and understand those rules.

Connect the instrument and the Windows PC; see the sub-section above 2. Connecting The Instrument To
A Computer in order to establish this connection.

Once the instrument/PC connection is established, refer to the following sub-sections in Section 2 — PC
Data Acquisition Software in order to acquire new measurements on the PC:

*  See “Control->Setup Instrument...” for basic software connection instructions.

*  See “Control->Setup Overlap/Matching...” for instructions on how to configure theses
settings, as they are applied to both downloaded and newly acquired spectral data.

*  Use the PC Data Acquisition’s “Reference” and “Target” buttons (or their equivalent
keyboard hot-keys “R” and “T) to acquire spectral data.

5. PDA Data Acquisition

See Appendix F — PDA Data Acquisition Software for instructions on how to use the optional PDA
device to acquire spectral data.
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Section 4 — Battery Charger

1. Introduction
The battety charger charges one (1) lithium-ion battery. The charger operates from 110/240 volt AC line
voltage. The battery charger directions must be followed for safe, correct operation. Charging should only

take place indoors, in a cool place.

The normal charge time for a completely discharged battery is approximately 5 hours. Two chargers are
provided with the instrument so that both batteries can be charged overnight..

2. Charger Specifications

STANDARD CHARGER:
Input: 100 — 240VAC, 0.3A (Max), 50/60Hz, Output: 8.4 VDC, 1.3A (Max)

FAST CHARGER:
Input: 100 — 240VAC, 0.9A (Max), 50/60Hz, Output: 8.4 VDC, 2.7A (Max)

3. Battery Pack Information And Warnings

Cells: 2 Li-Ion cells connected in seties: 9000mAh, 3.7V each.

Protection: 4A max polyswitch is installed in the battery pack for double over-discharging protection.
The battery will be automatically cut off to zero (0) volts when its voltage is too low for proper operation.
WARNING:

*  Avoid heavy impact to the battery pack; this may cause the battery pack to malfunction.

* Do not expose the battery pack to fire or extreme heat; this may cause the battery pack to
malfunction.

* Do not use any DC power supply or charger other than the charger supplied with the
instrument, this may cause the battery pack to malfunction.

Figure 7 Battery Pack (Left), Fast-Charger (Middle), and Standard Charger (Right)
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4. Charging
1. Plug the charger’s round male plug into the battery pack’s female jack.
2. Plug the charger into an AC outlet.

The charger’s RED LED will be illluminated during charging; when charging is complete, the charger’s
GREEN LED will be illuminated.

Charging a battery from empty to full capacity will take approximately 5 hours.
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Spectral Range
Number of Channels

Type of Sensors

Resolution

Integration Speed

Unit Size

Unit Weight
Battery Weight
Internal Memory
Sighting

Display

I/0s

Standard Foreoptics

Optional Foreoptics

Power

Environmental

Cleaning

Appendix Al — HR-1024i Specifications

350 nm to 2500 nm
1024 (including overlapped channels)
512 Channel Silicon Array

256 Channel InGaAs array
256 Channel Extended InGaAs array

< 3.3 nm FWHM @ 700 nm
<9.5nm FWHM @ 1500 nm
< 6.5 nm FWHM @ 2100 nm

1 - 1000ms

8.75" wide, 3.0” high, 11.5" long
22 cm. wide, 8 cm. high, 29 cm. long

8.5 1bs (3.8 kg)

1.51bs (0.7 kg)

1000 scans maximum

Diode laser at 635 nm

4.3” LLCD touchscreen with real time spectral and
sample image display

Laser, Ready & Power LEDs

Real time spectral display with PDA/PC

2 Bluetooth, USB A & B ports, & 12 pin external
trigger

4° Nominal FOV

8° Nominal FOV

14° Nominal FOV

25° Fiber Optic Light guide, vatious lengths
Irradiance Spheres and Diffusers

Li-Ton Battery operated, 6.5 — 8.0 VDC @ 2.5A

Temperature: -10C to +40C
Humidity: <90%, non-condensing

Wipe down exterior with soft, dry cloth only.
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Spectral Range
Number of Channels

Type of Sensors

Resolution

Integration Speed

Unit Size

Unit Weight
Battery Weight
Internal Memory
Sighting

Display

I/0s

Standard Foreoptics

Optional Foreoptics

Power

Environmental

Cleaning

Appendix A2 — HR-768i Specifications

350 nm to 2500 nm
768 (including overlapped channels)
512 Channel Silicon Array

128 Channel InGaAs array
128 Channel Extended InGaAs array

< 3.3 nm FWHM @ 700 nm
<16 nm FWHM @ 1500 nm
< 14 nm FWHM @ 2100 nm

1 - 1000ms

8.75" wide, 3.0” high, 11.5" long
22 cm. wide, 8 cm. high, 29 cm. long

8.4 Ibs (3.8 kg)

1.51bs (0.7 kg)

1000 scans maximum

Diode laser at 635 nm

4.3” LLCD touchscreen with real time spectral and
sample image display

Laser, Ready & Power LEDs

Real time spectral display with PDA/PC

2 Bluetooth, USB A & B ports, & 12 pin external
trigger

4° Nominal FOV

8° Nominal FOV

14° Nominal FOV

25° Fiber Optic Light guide, vatious lengths
Irradiance Spheres and diffusers

Li-Ton Battery operated, 6.5 — 8.0 VDC @ 2.5A

Temperature: -10C to +40C
Humidity: <90%, non-condensing

Wipe down exterior with soft, dry cloth only.
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Spectral Range
Number of Channels

Type of Sensors

Resolution

Integration Speed

Unit Size

Unit Weight
Battery Weight
Internal Memory
Sighting

Display

I/0s

Standard Foreoptics

Optional Foreoptics

Power

Environmental

Cleaning

Appendix A3 — HR-640i Specifications

350 nm to 2500 nm
640 (including overlapped channels)
512 Channel Silicon Array

64 Channel InGaAs atray
64 Channel Extended InGaAs array

< 3.3 nm FWHM @ 700 nm
<30 nm FWHM @ 1500 nm
<28 nm FWHM @ 2100 nm

1 - 1000ms

8.75" wide, 3.0” high, 11.5" long
22 cm. wide, 8 cm. high, 29 cm. long

8.4 Ibs (3.8 kg)

1.51bs (0.7 kg)

1000 scans maximum

Diode laser at 635 nm

4.3” LLCD touchscreen with real time spectral and
sample image display

Laser, Ready & Power LEDs

Real time spectral display with PDA/PC

2 Bluetooth, USB A & B ports, & 12 pin external
trigger

4° Nominal FOV

8° Nominal FOV

14° Nominal FOV

25° Fiber Optic Light guide, vatious lengths
Irradiance Spheres and diffusers

Li-Ton Battery operated, 6.5 — 8.0 VDC @ 2.5A

Temperature: -10C to +40C
Humidity: <90%, non-condensing

Wipe down exterior with soft, dry cloth only.
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Spectral Range
Number of Channels

Type of Sensors

Resolution

Integration Speed

Unit Size

Unit Weight
Battery Weight
Internal Memory
Sighting

Display

I/0s

Standard Foreoptics

Optional Foreoptics

Power

Environmental

Cleaning

Appendix A4 — HR-768si Specifications

350 nm to 1900 nm
768 (including overlapped channels)

512 Channel Silicon Array
256 Channel InGaAs Array

< 3.3 nm FWHM @ 700 nm
<9.5nm FWHM @ 1500 nm

1 -1000ms

8.75" wide, 3.0” high, 11.5" long
22 cm. wide, 8 cm. high, 29 cm. long

8.0 Ibs (3.6 kg)

1.5 1bs (0.7 kg)

1000 scans maximum

Diode laser at 635 nm

4.3” L.CD touchscreen with real time spectral and
sample image display

Laser, Ready & Power LEDs

Real time spectral display with PDA/PC

2 Bluetooth, USB A & B ports, & 12 pin external
trigger

4° Nominal FOV

8° Nominal FOV

14° Nominal FOV

25° Fiber Optic Light guide, vatious lengths
Irradiance Spheres and Diffusers

Li-TIon Battery operated, 6.5 — 8.0 VDC @ 2.5A

Temperature: -10C to +40C
Humidity: <90%, non-condensing

Wipe down exterior with soft, dry cloth only.
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Appendix A5 — HR-512i Specifications

Spectral Range 350 nm to 1050 nm
Number of Channels 512
Type of Sensors 512 Channel Silicon Array
Resolution <3.2nm FWHM @ 700 nm
Integration Speed 10 - 1000ms
Unit Size 8.75" wide, 3.0 high, 7.0" long
22 cm. wide, 8 cm. high, 18 cm. long
Unit Weight 5.2 1bs (2.4 kg)
Battery Weight 1.51bs (0.7 kg)
Internal Memory 1000 scans maximum
Sighting Diode laser at 635 nm
Display 4.3” LLCD touchscreen with real time spectral and

sample image display
Laser, Ready & Power LEDs
Real time spectral display with PDA/PC

I/0s 2 Bluetooth, USB A & B ports, & 12 pin external
trigger

Standard Foreoptics 4° Nominal FOV

Optional Foreoptics 8° Nominal FOV

14° Nominal FOV
25° Fiber Optic Light guide, vatious lengths
Irradiance Spheres and Diffusers

Power Li-Ton Battery operated, 6.5 — 8.0 VDC @ 2.5A

Environmental Temperature: -10C to +40C
Humidity: <90%, non-condensing

Cleaning Wipe down exterior with soft, dry cloth only.
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Spectral Range
Number of Channels

Type of Sensors

Resolution

Integration Speed

Unit Size

Unit Weight
Battery Weight
Internal Memory
Sighting

Display

I/0s

Standard Foreoptics

Optional Foreoptics

Power

Environmental

Cleaning

Appendix A6 — XHR-10241 Specifications

350 nm to 2500 nm
1024 (including overlapped channels)
512 Channel Silicon Array

256 Channel InGaAs array
256 Channel Extended InGaAs array

<2.8nm FWHM @ 700 nm
< 8.0 nm FWHM @ 1500 nm
< 6.0 nm FWHM @ 2100 nm

1 - 1000ms

8.75" wide, 3.0” high, 11.5" long
22 cm. wide, 8 cm. high, 29 cm. long

8.5 1bs (3.8 kg)

1.51bs (0.7 kg)

1000 scans maximum

Diode laser at 635 nm

4.3” LLCD touchscreen with real time spectral and
sample image display

Laser, Ready & Power LEDs

Real time spectral display with PDA/PC

2 Bluetooth, USB A & B ports, & 12 pin external
trigger

4° Nominal FOV

8° Nominal FOV

14° Nominal FOV

25° Fiber Optic Light guide, vartious lengths
Irradiance Spheres and Diffusers

Li-Ton Battery operated, 6.5 — 8.0 VDC @ 2.5A

Temperature: -10C to +40C
Humidity: <90%, non-condensing

Wipe down exterior with soft, dry cloth only.
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Appendix B — File Descriptions

Signature File Format

The Signature (SIG) File Format is a text file that contains a header followed by spectral data information. Each line
of the header begins with a keyword tag, as defined below. NOTE: Some header fields (integration, scan method,

etc) should NOT change from reference to target, but are explicitly called out in the header for completeness).

Line | Keyword Tag Fields Description

1 /*** Spectra Vista SIG Data ***/ | None This line must appear exactly as shown in
order for the file to be recognized as a current
SIG format file.

2 name= F1 F1 is the SIG file name.

3 instrument= F1:F2 F1 is the instrtument’s model number.

F2 is the insttument’s extended serial number.

4 integration= R1,R2,R3,T1, T2, | R1, R2, R3 are the reference scan integration

T3 times (in milliseconds) for the Si, InGaAs1,
and InGaAs2 detectors respectively.

T1, T2, T3 are the target scan integration times
(in milliseconds) for the Si, InGaAs1, and
InGaAs2 detectors respectively.

5 scan method= R1,T1 R1/T1 is the reference/target scanning
method used to determine the length of the
scan:

“Time-based” — fixed scan time
“Coadd-based” — fixed coadd number

6 scan coadds= R1,R2,R3,T1,T2, | Rx/Tx is the reference/target coadds acquired

T3 as part of the scan for each spectrometer

7 scan time= R1,T1 R1 is the reference scan time setting (seconds).
T1 is the target scan time setting (seconds).

8 scan settings= R1,T1 R1 is the reference scan integration type (“Al”
= Auto integration , “FI” = Fixed integration,
“UI” = unknown)

T1 is the target scan integration type (“Al” =
Auto integration , “FI” = Fixed integration,
“UI” = unknown)

9 external data setl= R1,R2,R3,R4,R5, | R1-R8 are set #1 of the reference scan external

R6,R7,R8,T1, T2, | data samples, or [PC Software Only] O if

T3,T4,T5,T6,T7, | disabled.

T8 T1-T8 are set #1 of the target scan external
data samples, or [PC Software Only] 0 if
disabled.

Each sample is in the range —32K to +32K.

10 external data set2= R1,R2,R3,R4,R5, | R1-R8 are set #2 of the reference scan external

R6,R7,R8,T1,T2, | data samples, or [PC Software Only] O if

T3,T4,T5,T6,T7, | disabled.

T8 T1-T8 are set #2 of the target scan external
data samples, or [PC Software Only] 0 if
disabled.

Each sample is in the range —32K to +32K.

11 external data dark= D1,D2,D3,D4,D | D1-D8 are the most recent external dark data

5,D6,D7,D8 samples. These values are acquired when the
“Dark Scan” button is pressed.
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Each sample is in the range —32K to +32K.

12

external data mask=

X1

[PC Software Only] X1 is the 8-bit decimal
encoded value that represents which external
channel has been enabled. A “1” -> channel
enabled, or a “0” -> channel disabled.

For example, a mask value of 5 would mean
channels 1 and 3 are enabled.

External Data Masks values range from 0 (no
channels enabled) to 255 (all channels
enabled).

13

optic=

R1, T1

R1 is the fore-optic name in use in the
reference scan.

T1 is the fore-optic name in use in the target
scan.

14

tempz

R1,R2,R3,T1,T2,
T3

R1, R2, R3 are the reference scan reported
temperatute values (in °C) for the Si, InGaAsl,
and InGaAs2 detector respectively.

T1, T2, T3 are the target scan reported
temperatute values (in °C) for the Si, InGaAsl1,
and InGaAs?2 detectors respectively.

15

battery=

R1,T1

R1/T1 is the repotted battery voltage duting
the reference/target scan.

16

error=

R1,T1

R1/T1 is the repotted error code (if any)
during the reference/target scan. An etror
value of 0 (zero) means no error occurred.

17

units=

R1, T1

R1/T1 ate the types of units associated with
the scan data:

“Radiance” — units of radiance

“Irradiance” — units if irradiance

“Counts” — raw counts uncorrected for
calibration factors

18

time=

R1,T1

R1/T1 is the system time that the
reference/target scan was acquired.

19

longitude=

R1,T1

R1/T1 is the GPS reported longitude when the
reference/target was acquired. GPS fields ate
blank if the optional GPS unit is not installed,
or was not producing position information at
the time of the scan. (The exact format is
described below in the SIG File GPS Data
Format paragraph).

20

latitude=

R1,T1

R1/7T1 is the GPS reported latitude for the
reference/target scan.

21

gpstime=

R1,T1

R1/T1 is the GPS reported time for the
reference/target scan.

22

comm=

F1

The F1 field provides space for any user-
supplied comment.

23

memory slot=

R1,T1

If the spectral data was originally acquired by
in stand-alone mode, R1/T1 are the internal
scan numbers within the HR-1024i’s scan
memoty.

If the data was acquired by the PDA or PC
Acquisition Software, these fields are both set
to 0 (zero).

24

factors=

F1,F2,F3

F1/F2/F3 are the matching factors used to
match Si and InGaAs1 detector data.
I'1 is the reference radiance matching factor.
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I2 is the target radiance matching factor.
I3 is the reflectance matching factor.

25

data=

None This tag marks the beginning of the spectral
data. The format of each line of spectral data is
described below in the SIG File Spectral Data
Format paragraph (below).

SIG File GPS Data Format

Note that the GPS information in the header is only available when an optional GPS data source is installed in the
PDA. When present, the GPS components have the following format:

where:

GPS Longitude
GPS Latitude
GPS Time

wrois g

DDDmm.mmmmC
DDmm.mmmmC
HHmmSS.SSS

is degrees

is decimal minutes

is quadrant (N, S, E, W)

is hours (GMT, 24-hour format)
is seconds

Note that depending on the GPS source, the exact format may vary; for example, there may be fewer significant
decimal points present for the Lat/Lon “minutes” field, or the Time “seconds” field may be truncated to contain

only integral values.

SIG File Spectral Data Format

Following the header are four columns of data:

Column 1: Wavelengths (nanometers)
Column 2: Reference Values (see below)
Column 3: Target Values (see below)
Column 4: Reflectance (percent)

Reference/Target Values® units depend on which calibration table ot fore-optic was in use:

Radiance: 1010 * W/(cm? * nm * sr)
Irradiance: 10-19* W/ (cm? * nm)

RAW DN: counts
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SIG File Example:

/*** Spectra Vista SIG Data **/
name= dltest_0000.sig

instrument= F1: 0503353
integration= 200, 135, 145, 200, 135, 145
scan method= Time-based, Time-based
scan coadds= 14, 23, 78, 14, 23,78
scan time= 5, 5

scan settings= Al Al
external data set1=0, 0, 0, 0, O,
external data set2= 0,0, 0,0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0, 0,
external data dark= 0,0,0,0,0,0,0,

external data mask= 0

optic= Opticl, Opticl

temp= 25.3,-1.2,-5.7, 25.3, -1.2, -5.7

battery= 8.16, 8.15

error= 0, 0

units= Radiance, Radiance

time= 2/28/2006 2:37:42 PM, 2/28/2006 2:37:48 PM
longitude= 07351.2674W, 07351.2674W

latitude= 4140.6700N, 4140.6700N

gpstime= 193332.68, 193332.68

comm= comments go here

memory slot=1, 2

factors= 0. 980, 0.972, 1.000

data=

357.7 584.00 485.00 83.05

359.3 606.00 506.00 83.50

360.9 697.00 532.00 76.33

362.5 676.00 504.00 74.56

364.1 700.00 524.00 74.86

365.7 724.00 544.00 75.14

367.3 744.00 565.00 75.94

368.9 768.00 584.00 76.04

0,0,0,0,0,0,0,0,0,0,0
0,0,0,0,0,0,0,0,0,0,0
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White Plate Reflectance Data File Format

The White Place Reflectance Data File is a two-column text file. The first and second columns are separated by
white space (either TAB or SPACE characters).

The first column contains wavelength values, in nanometers. The file should include all wavelengths in the
instrument’s spectral range.

The second column contains reflectance values that correspond to the white plate’s true reflectance at each
wavelength.

White Plate Reflectance Data File Example:

A typical (truncated) white plate reflectance data file appears below:

250 0.949
251 0.949
252 0.952
253 0.953
254 0.953
255 0.955
256 0.955
257 0.956
258 0.957
259 0.958
260 0.958
201 0.958
262 0.959
263 0.960
2064 0.960
265 0.960
2492 0.945
2493 0.945
2494 0.944
2495 0.943
2496 0.946
2497 0.946
2498 0.947
2499 0.948
2500 0.946
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PDA Software COM Port Configuration File

A software initialization file named:
“HR1024i_INILtxt” (PDA software version 1.0),
or
“SVCscan_INILtxt” (PDA software version 1.1 and later)

can be found in the PDA folder “My Device\Program Files\Spectra Vista\”. This file contains a list of COM ports
that the PDA Software uses for communicating with the instrument.

The file has the following (example) 2-line format:

COM1
COMS

Where:
Line 1 (COM1 in the example above) is the PDA’s 9-pin RS-232 serial port.
Line 2 (COMS in the example above) is typically the PDA’s Bluetooth COM port.
The COM ports that are available to the PDA Software may vary, depending on the PDA’s configuration.

If the COM ports listed in the INT file do not match the COM ports configured into the PDA operating system,
then the PDA will not be able to communicate correctly.
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Appendix C — Laser Safety

The instrument uses a Class 3R laser beam that complies with IEC 60825-1, Ed. 1.2.
The source of laser energy is a nominal 3 mw, continuous, 635 nm diode laser. No
maintenance or adjustments are required in order to keep this product in compliance
with the above specifications.

DANGER Do not look into the laset beam at any time including instrtument setup or
operation.

The laser is operated by pressing the Laser Scan Switch located on the top surface of
the instrument. See Section 2. HARDWARE DESCRIPTION, for the location of
this control.

CAUTION - Use of controls or adjustments or performance of procedures
other than those specified herein may result in hazardous radiation exposure.

There are no user serviceable components within this device. The unit should be
returned to the manufacturer in case of malfunction.

LABELING The following labels are required. Each label is described below. If the instrument
does not have the appropriate labels, contact the manufacturer to ensure that your
unit is in compliance.

-,

(1) Explanatory Label

LASER RADIATION
AVOID DIRECT EYE EXPOSURE

CLASS 3R LASER PRODUCT
=5mW CW 400-625nm

\ )

Location - Front panel near fore-optic mount.

(2) Warning Label

Location - Front panel near fore-optic mount.
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Appendix D — PC Third Party Bluetooth

Usage

The instrument supports Bluetooth connections from PCs for the purpose of transferring data and control
information between the instrument and the connected PC. It is the customer’s responsibility to purchase,
install, and configure the appropriate PC Bluetooth hardware using this appendix as a guide.

Instrument-Specific Bluetooth Information

Bluetooth Versions Supported: V1.1

Bluetooth Class: Class I

Bluetooth Connection Type: Virtual COM Port, un-secure connection.

Bluetooth Connection Password: This password is exchanged between the PC or PDA Bluetooth driver
and the instrtument during the initial Bluetooth discovery/association process. The password is
dependent on the model number of the instrument, as defined below:

Model Bluetooth Password
XHR-10241 xhr1024i
HR-1024i hr1024i

HR-768i ht768i

HR-640i hr640i
HR-768si hr768si

HR-512i hr512i
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Appendix E — PC USB Device Drivers

Installing USB Device Drivers On The PC

To install USB device drivers under Windows XP, follow the instructions below. Please read through all
the instructions before beginning. The USB Device Drivers are only necessary if you plan to connect
your instrument to the PC using a USB cable.

Do not plug the instrument into the Windows XP USB port until instructed below.

1. You must install the PC Data Acquisition Software before following this procedure, as the
procedure uses files that are part of that installation. See Section 2 — PC Data Acquisition Software —
Sub-section 1. INSTALLATION above installation instructions.

2. If you are re-installing the USB drivers, the original drivers need to be first uninstalled. Please refer to
the Removing USB Device Drivers section below for details of this procedure.

3. If your Windows XP machine is connected to a network, temporarily disconnect from that network.
This will prevent the Windows “Found New Hardware Wizard” from automatically connecting to the
Windows Update website, and downloading and installing the wrong drivers for the instrument.

4. Connect the instrument to a spare USB port on your PC, and power-up the instrument. This will
launch the Windows “Found New Hardware Wizard”. If there is no available Internet connection or
if Windows XP SP 2 is configured to ask before connecting to Windows Update, the screen below is
shown. Select "No, not this time" from the options available and then click "Next" to proceed with
the installation.

[& A

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Windows will zearch for current and updated software by
looking on your computer, on the hardware installation CO, or on
the Windows pdate \Weh site [with pour pernizsion].

Read our privacy policy

Can Windows connect to Windows Update to search for
zoftware?

) e, this time only
(T *es, now and every time | connect a device
&) No, nat this time

Click Mext to continue,

Mext » ][ Cancel
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5. Select "Install from a list or specific location (Advanced)" as shown below and then click "Next".

Found New Hardware Wizard

5

Thiz wizard helps pou inztall zoftware for:

DLP2232M

_'#J If your hardware came with an installation CD
<2 or floppy disk. insert it now.

What do you want the wizard to do?

7 |nztall the software automatically [Recommended)

% Inztall fram a st or specific location [Advanced}

Click Mext to continue,

¢ Back I et > I Cancel

6. Select "Seatch for the best driver in these locations" option, and use the “Browse” button to select the
location of the USB driver files. The instrument’s USB drivers are included as part of the PC Data
Acquisition Software installation, in a folder called “USB Driver” that may be found in the PC Data
Acquisition Softwate installation folder (typically, “C:\Program Files\Spectra Vista\HR1024i\”).
Once the file path has been entered in the box, click “Next” to proceed.

Found New Hardware Wizard

Pleaze choose your search and installation options. %

(*) Search tor the best driver in these locations.

Llze the check boses Eelow b imst or expand the default search, which includes local
paths and removable redia. The best dives found will be installed.

1 Seatch removable media [floppy. CD-ROM...)
Ihciude this locaion in the search:

| C:\Program Files\Spectra VistalHR 1024\USE Driver |+ j Browse

() Dot search. | will chioss the driver bo nstal

Chooze thiz option bo select the device daver from a kst Windows doez not guarantee that
the drivier you chooze will be the best match for pour hardware.

¢ Back ][ Mest » ][ Cancel
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7. The following screen will be displayed as Windows XP copies the required driver files.

Found New Hardware Wizard
Pleaze wait while the wizard installz the software. .

% USBE Sernial Coreerter

r."_l-’ - : _---“"'-‘:"F
ftdiunin, exe
To ChWINDOWShaystem3d

8.  Windows should then display a message indicating that the installation was successful. Click "Finish"
to complete the installation. This has installed the serial converter. The COM port emulation driver
must be installed after this has completed.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

5

The wizard haz finished installing the zoftware for;

% USE Senal Comverter &

Click, Finigh to cloge the wizard,

2 Back Earcel
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9.  After clicking "Finish", the Found New Hardware Wizard will again appear (See Step 4 above);
Continue by installing the COM port emulation driver. The procedure is the same as that above for
installing the Serial Converter driver above.

10. When both driver installations are complete, open the Device Manager (located in "Control

Panel\System" then select the "Hatdwate" tab and click "Device Manget") and select "View >
Devices by Type". The device appeats as an additional COM port with the label "USB Serial Port".

£, Device Manager,

File  Action®  Miew Help

s 2 &
i J Campuker *

¥
+i- g Disk drives

+ g Display adapters

+- 24 MNfCn-ROM drives
++4=2 Floppy disk controllers

+-i=) IDE ATAJATAPT controllers
+|-&5 IEEE 1394 Bus host conkrallers
+ ,Ej Infrared devices

¥z Kevboards

+ ‘J Mice and other pointing devices
+ Ed, Modermns

¥ ‘rg Manitars

+ - B8k MNetwork adapters

- @ PCMCIA adapters

= Ports (COM & LPT)

.. ¥ 115B Serial Port (COMS)
+- 3% Proceasor
+ @?- Sound, video and game controllers

+ o System devices
+- Universal Serial Bus controllers w

11. In the example above, the USB Driver was installed on “COMS5”. You should note which COM
port is assigned to your installation, and use this same COM port number in the PC Data
Acquisition Software’s “Control->Setup” dialog.

12. Also, please note: If you later plug in the instrument to a different USB port on your PC, the USB
Serial Port driver may assign a different COM number to the connection, and you will have to change
that COM number in the PC Software’s Control->Setup” menu. To avoid this, try to plug the
instrument into the same physical USB port on the PC each time.
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Removing USB Device Drivers From The PC
To uninstall USB Device Driver, follow the instructions below:
1. Disconnect the instrument from the PC (if attached).

2. Open the Add/Remove Programs utility located in "Control Panel\Add/Remove Programs". Select
"FTDI USB Serial Converter Drivers" from the list of installed programs.

3 -— Sp—
% Ldd or Remove Programs = @J&l

Fo -
\ﬁ"ﬂ Currently installed programs: [] Show updates Sort byt | Mame i
Change or =] n T
e figt FTDI USB Serial Conyerter Drivers
Pragrarms 0
- Tochange this progeanor remmoye it from your computer, click ChangefRemove. ChengefRemove
ot .Il..u Help & Manual 3.25 Size. 51.79MEB
Add hew |§5) Lucent Technologies Soft Modem AMR
Programs |
[EmProg 2.0 Sz 2.25ME
@ |15 WvIDIA Windaws 2000/¥F Display Drivers
Add/Remove 5£ FGLing Siz= 0.76MB
indows g i
Sokp #] Tera Term Pro Size 1,31ME
ﬁ__?;! Windows XP Service Pack 2
Set Pragram
Access and
Cefaults

3. Click the "Change/Remove" button, and follow the instructions to uninstall the drivers.
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Appendix F — PDA Data Acquisition Software

Overview

This appendix documents the usage of PDA Data Acquisition Software application on a PDA (Personal Digital
Assistant) using the Microsoft Windows Mobile operating system. The application will be referred to as just “the
PDA application” throughout this appendix.

The main features and functionality of the PDA application are similar to that of its counterpart on the PC. It
collects data from a hand held spectroradiometer, saves the data to the PDA’s internal memory, and displays the
graph in different views.

For general knowledge about the spectroradiometer, please consult the earlier sections of this manual.

Information regarding the PDA, outside of its specific use with the spectroradiometer may be found in the PDA
manufacturer’s User Guide.

PDA Requirements

PDA Type: Windows Mobile
Operating System: Windows Mobile 6.x
Interfaces: RS-232, and/or Bluetooth virtual com port serial services.
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PDA Software — Quick Reference

1. Power on the instrument.

2. Power on the PDA and start the application program by tapping
PDA Software 1.0: Start->HR1024ipda
PDA Software 1.1 or later: Start->SVCscan

3. Select “Connect” to display a list of COM ports.

4. Select appropriate COM port to establish communication to the instrument. COMT is the serial cable
connection and the other COM port is typically the Bluetooth connection.

5. The PDA will communicate with the instrument and upload current settings and calibration files.

6. The instrument’s current settings will be displayed in the Settings Dialog Box.

7. Select the settings to be used and press OK.

8. Begin Acquisitions by

a.  Pressing “REFERENCE” with a white plate in the targeting area to acquire a reference scan.
b. Pressing “TARGET” with a target in the targeting area.

9. View Data: While in Graph->Radiance mode, the radiance graph will automatically appear upon
reference or target acquisition completion. In Graph->Reflectance mode, the reflectance graph will
automatically appear on target acquisition completion.

10. Save Data: Data will automatically be saved to the PDA's memory when the AutoSave Menu option
is checked. When AutoSave is not checked, the acquired data may be manually saved to file using File-
>Save menu; a dialog box will appear, prompting for a filename. Input a filename and click OK. Data
will be stored to the selected file name.

11. Upload files to PC for analysis. SIG format data files can be uploaded for viewing by the PC Data
Acquisition Software or other packages for analysis. The files are transferred from the PDA to the

Host PC using the Microsoft ActiveSync software via a USB connection. The default location of SIG
files on the PDA is in the folder:

PDA Software 1.0: \My Documents\HR1024i Data\

PDA Software 1.1 or later: \My Documents\SVC Data\
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PDA Software Application — Detailed Usage

Introduction

The PDA Data Acquisition Software application is based on the interface and functionality of the PC Data
Acquisition Software for the i-Series family of spectroradiometer.

The name of the application, as well as the INI file and default data folder varies with the version of the PDA
software:

PDA SW PDA App Name INI File Name Default Data Folder Under
Version /My Documents/
1.0 HR1024i PDA HR1024i_INI.txt HR1024i Data
1.1 and later | SVCscan SVCscan_INI.txt SVC Data

Data File Format

Data files are stored as plain text in the SIG format. See Appendix B — File Descriptions for information on SIG
format data files).

DATA FILE NAMING CONVENTION (AUTOSAVE)

When in AutoSave mode, the software automatically creates and saves SIG format data in files that are named
according to the template “HR.mmDDyy.CCCC.sig”, where:

*  The field HR is the literal string “HR”

*  The fields mm, DD, and yy are the current month, day, and year respectively as determined by the
PDA’s clock setting.

*  The field CCCC is the value of the AutoSave File Counter field as shown on the PDA application
main screen (see below).
*  The .sig filename extension identifies this as a SIG format spectral data file.

DATA FILE LOCATION
See the default data folder column in the table above.

Startup

On the PDA press the On/Off button. The PDA application can be started by tapping the Start button in the
corner of the PDA power-on screen, and selecting the PDA program.
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ﬂ‘.? Today

[ Office Mobile

[E3 Calendar

FE Contacts
' HR1024iPDA
{2 Internet Explorer
= Messaging

[ File Explorer

n Programs
B\ settings
{7 Help

e
e

12:14 PM

SVCscan

Calendar

imformation

Pictures & Videos

- - A
: Ealenar o Contacts @

Figure 8 PDA Start Menu Windows Mobile 6.0 (left) and Windows Mobile 6.5 (Right)

Operation

The Menu Bar for the PDA application is situated at the bottom of the window. There are 4 menu items on the
Menu Bar, named from left to right as “File”, “Graph”, and “Instrument”, and “Help”; and two large Command
Buttons on the top labeled “Reference” and “Target” (See below.)

f; | S¥LC HR-1024

] Radiance  Scan:0000
0

350 Wiyl (nim) 2500
File Graph Instrument Help
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The Graph Type text field just above the graph area displays which graph display (Radiance or Reflectance) is in
effect within the rectangular Graphing Area.

The AutoSave File Counter (Scan:0000 in the example above) displays the value of the counter that is used to
form the next AutoSave file name. The counter is incremented after each target acquisition while in AutoSave
mode. This counter may be used to tie together AutoSaved file names with notes taken regarding targets during field
acquisitions. By convention, the AutoSave file name has the format “HR.mmDDyy. XXXX.sig”, where XXXX is the
value of the AutoSave File Counter. Note that this counter displays the count of the next target acquisition,
not the currently displayed target acquisition.

The following sections describe these features in more detail.
COMMAND BUTTON “REFERENCE?

The “Reference” button is used to initiate a Reference scan acquisition by the instrument. The instrument must be
“connected” to the PDA for a successful scan to be acquired. Once the scan is acquired the Radiance result will be
displayed graphically if the graph is configured to display Radiance.

COMMAND BUTTON “TARGET”

The “TARGET” button is used to initiate a Reference scan acquisition by the instrument. The instrument must be
“connected” to the PDA for a successful scan to be acquired. Once the scan is acquired, the Radiance result will be
displayed graphically (if the Graph mode is set to display Radiance) or the Reflectance result will be displayed (if the
Graph mode is set to Reflectance). The acquired scan can then be saved to file manually, using the FILE>SAVE
menu, or it will be automatically be saved if the File->AutoSave option is checked.

MENU BUTTON “FI LE”?

s SYCHR-10
0 Radiance  Scan:0000
 save Wl () 2500
Header R
v RutoS
u_ OFAVE ot conmected. .
Exit
File| Graph Instrument Help

The drop down menu list for “File” consists of the following menu items:
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Open Displays a dialog for a user to select and open an existing PDA SIG file for
display.
New Displays a dialog for a user to specify a new base name for future scan

acquisitions; a 4-digit value, starting at 0000, is appended to each future scan
and incremented with each target acquisition.

Save Displays a dialog for a user to select a filename and save the current scan to a
SIG data file generated by the PDA application.

Header This is a check box option which causes header information to be displayed in
the application. When checked, a text box appears containing the header data.
The header data is described in the SIG File Format. When unchecked, the
header text box is not visible.

AutoSave This is a check box option that causes measurements to automatically be saved
to file after each target acquisition. Files will be generated in SIG format, and
will be named according to the convention: “HR.mmddyy.nnnn.sig”, where
mmddyy is the date and nnnn is the current value of the AutoSave File
Counter (ranges from 0000 to 9999.)

Exit Exits the application.
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MENU BUTTON “GRAPH”

0 Radiance  Scan:0000
0
350 Wiyl (i) 2500
IE v Radiance _ pymmmr
Reflectance
File |Graph|Instrument Help

The dropdown menu list for “Graph” is composed of the following menu items:

Radiance: Sets the graphic display mode to Radiance to display data in Radiometric Units.
The Y-axis Radiance units are hw/cm”™2/nm/st x 107(-10) and the X-axis is
Wavelength in nanometers(nm).

Reflectance Sets the graphic display mode to Reflectance to display data in Percent
Reflectance units. The Y-axis Reflectance units are percent (%) and the X-axis

is Wavelength in nanometers(nm). Reflectance is the ratio of the target scan
vector to the reference scan vector.

MENU BUTTON “l NSTRUVENT”

The dropdown menu list for “Instrument” has the following menu items:
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o Radiance  Scan:0000

0

350  pmsishies 2500

L.
v

Settings
Instrurnen 9 thed, ..
Status
File Graph |Instrument|{Help

Connect Connect is used to connect the PDA to an instrument. When
Connect is selected, the PDA displays a list of COM Ports in a new
screen. The COM port that is to be used to connect to the
instrument needs to be selected.

The COM Ports listed are controlled by a PDA Software
configuration file; see Appendix B — File Descriptions, PDA Software
COM Port Configuration File for more information.
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f; Port Selection

Comm. Port: oML -
DK Cancel

Selecting a COM portt option causes the PDA to make a connection
with the instrument. If successful, the Status menu will display a
message indicating an instrument is connected and the Settings screen
will automatically appear (See SETTINGS FORM below.)

Settings The Settings menu is used to modify instrument data collection
parameters. When selected a dialog box will appear, presenting
vatious options (See SETTINGS FORM below.)

Status This indicates the instrument connection status.
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SETTINGS FORM

Integration Setting:

ERNEE

Si mS

x: EMS 4 -
; . Swirl |32
Photo Mode: Photo Mode:
e <] swe 2T
{ ) Coadds () Scan Time (® |Coadds ¥ Scan Time

— |
=
=
m

Integration Setting:

Auto Ato

DK

Cancel (0]'4

Photo Mode:

Scan Time / Coadds:

Optic

Integration Settings Auto

Control the JPEG target camera that is internal to the instrument.
The setting are:

0 OFF (no photos are acquired during target data acquisition),
0 LOW-RES (320x240 photos acquired)
0 HI-RES (640x480 photos acquired)

These radio button control the way scans are acquired, either by
setting a fixed scan time limit per scan (with varying number of co-
adds), or by setting a fixed number of coadds per scan (and so
varying the total scan time).

Depending on whether Scan Time or Coadds mode is selected, the
appropriate control in the upper half of the setup dialog is enabled
(see above):

0 A single “Sec” setting — controls the total Scan Time per
scan.

0 Ttiple VIS/Swirl/Swir2 settings — controls the number of
coadds acquired for each spectrometer, per scan.

Sets the optic that is in use for data collection. This setting must
match the actual foreoptic installed on the instrument, in order to
obtain correct radiometric data. The menu options are determined
by factory setting.

When Auto is checked, the instrument automatically determines the
optimal integration settings for all detector arrays (Si, Swl, and Sw2).
When Auto is not checked, the operator may set individual
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integration times for each detector atray, using the Si/Sw1/Sw2
controls in the lower half of the setup dialog.

OK When OK is pressed the settings are sent to the instrument and used
for operation.
Cancel When Cancel is pressed, no changes are made to the settings.
MENU BUTTON “HELP”

The dropdown menu list for “Help” has the following menu items:

0 Radiance  Scan:0000
0

350 Wiyl (him) 2500
|Er‘|5trumer‘|t is not conrgstas
File Graph Instrument

About: Displays PDA software version information
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Appendix G — PDA Usage Tips

PDA Reset Procedures — Trimble Juno T41

Figure 9 Ttimble Juno T41 PDA

Juno T41 Soft Reset / Turn-off Procedure

The Juno T41 PDA may be Soft Reset by briefly (1-2 seconds) pressing then releasing the green reset
button located on the right-hand side of the PDA:

Figure 10 Juno T41 PDA Side View Showing Green Reset Button

This will bring up the Power Menu on the PDA screen (below). If this does not occur, a Hard Reset may
be necessary.

To perform a Soft Reset, tap the “Reset” button to Soft Reset the PDA. The PDA screen will go blank
and the PDA will reboot within several seconds.

To turn off the PDA, tap the “Shutdown” button. This is important to save battery life.

PowerMenu [ & & o @ 233

Enable
Shutdown Airplane
mode
Reset Vibration On

Select an option by tapping.

Figure 11 Juno T41 PDA Power Menu Screen

Note: Performing a Soft Reset simply restarts the PDA operating system. It is similar to re-booting a PC.
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Juno T41 Hard Reset Procedure

If a Soft Reset does not work, then a Hard Reset may be necessary.
The Juno T41 may be Hard Reset by pressing and holding the green reset button located on the right-hand
side of the PDA until the PDA screen goes blank and the reboot process begins. Note that it may be

necessary to hold the button for as long as 20 seconds in order for the reset to take effect.

Performing a Hard Reset does not affect the contents of the software on the PDA and may be peformed
without causing any software issues.

PDA Reset Procedures — Trimble Recon 400X

[ e

¥, @

Figure 12 Trimble Recon 400X PDA

Recon 400X Soft Reset Procedure

The Recon 400X PDA may be Soft Reset by pressing and holding the Power Key (shown below) until the
PDA screen indicates the soft reset is in progress. Note that if the PDA is hung, the key may have to be
held down as long as 60 seconds before the soft reset takes place.

- @-Trimble.

POWER KEY

400X SOFT RESET KEYS

Note: Performing a Soft Reset simply restarts the PDA operating system. It is similar to re-booting a PC.

Recon 400X Hard Reset Procedure

Warning: Hard Resetting the PDA will require re-installation of the PDA application, either from
internal PDA Backup, or from CD.

The Recon 400X PDA may be Hard Reset by:
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Pressing and holding the Power Key (shown below) until the PDA displays a countdown.
. Continue to hold the Power Key until it counts to zero and beeps twice.

3. Release the Power Key and immediately press and hold the Start and OK keys
simultaneously.

N —

-2 Trimble.

START KEY OK KEY

POWER KEY

400X HARD RESET KEYS

PDA Power Up

If the PDA is turned off, or automatically powers down while the PDA application is in use, it may be
necessary to perform a Soft Reset on the PDA, followed by a restart the PDA application.

In general, after turning on the PDA and before beginning a series of new scans with the PDA application,
it is recommended that the operator always first perform a Soft Reset on the PDA.

PDA Charging

Even when not in use, the PDA should be periodically recharged every few weeks. This process allows the
PDA’s internal backup battery to maintain the PDA application installation and configuration.

Failure to maintain the charge on the PDA’s internal backup battery will cause the PDA application to be
lost. In this case the PDA application must be re-installed.

PDA COM Ports And PDA Application Software

The PDA Application Softwate’s “Instrument->Connect” menu displays a list of COM ports that are
available to establish the connection to the instrument. A typical list, as displayed, is shown below:
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Comm. Port:

ComMg
oM

ew':“-'&m O RTRRR

0K

Cancel

The list of COM ports displayed in this dialog (COM1 and COMS in the example above) may vary from

one PDA installation to another.

The COM ports show in the dialog are read from the application’s initialization files at program startup.
See the section PDA Software COM Port Configuration File for the format of this initialization file.

The COMT1 port is typically fixed and corresponds to the 9-pin RS-232 connector found on the PDA.

The other COM pott listed is the Bluetooth COM port. The COM port listed must correspond to the
COM port configured into the PDA’s Bluetooth driver, or it will not be possible to communicate with the

instrument via Bluetooth.
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Appendix H — Instrument Remote Access

GENERAL PROTOCOL DESCRIPTION

The PC Data Acquisition Program can act as the access point that will allow a customer to remotely control the
instrument from a custom software application. The access allows the customer's softwate to:

*  trigger a reference or target scan

*  receive the results of a target scan

*  control spectrometer settings (fore-optic selection, scan timing, scan integration)

In order to control the instrument, the PC Data Acquisition Program acts as a network server. This network server
function listens for TCP/IP socket connections from the customet's (client) software. The customet's client
software sends trigger commands to the server, and receives responses and spectral data from the server.

Functionally, the operator first uses the PC Data Acquisition Program in the standard way - connect to the
instrument and set the desired scan parameters (Scan Time, Integration, Auto Dark, Optic, Ovetlap/Matching, etc).

Once the desired scan parameters ate set, the operator causes the PC Data Acquisition Program to enter into its
“Remote Server” listening mode. At this point, the customet's client software is able to connect via a TCP/IP
network socket and remotely control the instrument.

See the description of the Remote Access Tool in Section 2 — PC Data Acquisition Software for specific controls and
descriptions on how to setup the PC Data Acquisition Software to act as a remote server.

DETAILED PROTOCOL DESCRIPTION

All the client/server communication uses simple human-readable ASCII commands and responses.

The client and server software may reside on the same (Windows) computer, or may reside on different computers
that are connected via a TCP/IP network.

The PC program accepts and responds to the following commands from remote clients that want to remotely
control the connected instrument:

Reference Scan Command

Command: "R a<cr>" - This one-parameter command triggers a reference scan acquisition in the instrument.
Parameter “2” (the scan sub-type) — determines the characteristics of the Reference scan, per these values:

0 — acquire a normal scan — the spectroradiometer acquires both dark and light data; the dark is subtracted from
the light, and the resulting values are used as the reference.

1 — acquire a special light-only scan — the spectroradiometer acquires light data only; the dark data from a prior
scan is subtracted from the light data, and the resulting values are used as the reference. Note that a prior normal
scan must have previously been acquired by the spectrometer. Note also that this scan sub-type may not produce as
accurate results as the normal scan, where dark/light data are both acquired.

Example: “R 0<cr>” — acquire a normal reference scan.

Example: “R 1<cr>" — acquite a special reference scan.
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Normal Response: "r<ct><If>" - This three character response is sent back to the client after the reference scan
is complete. The reference scan may take up to 30+ seconds to complete, depending on the instrument's current
"Scan Time" or “Coadds” setting.

Error Response: "E: Reference Scan Error<cr><If>" - An error occurred while taking a reference scan. This
could be caused by a timeout or other communication etror between the PC and the instrument.

Error Response: "E: Wrong Number Of Parameters<cr><If>" — The client sent the wrong number of parameters
for this command.

Error Response: "E: Parameter Value Error" — The client attempted to set a parameter outside of it’s range of
valid values for this command.

Target Scan Command
Command: "T a<cr>" - This one-parameter command triggers a target scan acquisition in the instrument.

Parameter “2” (the scan sub-type) — determines the characteristics of the Target scan, per these values:

0 — acquire a normal scan — the spectroradiometer acquires both dark and light data; the dark is subtracted from
the light, and the resulting values are used as the target.

1 — acquire a special light-only scan — the spectroradiometer acquires light data only; the dark data from a prior
scan is subtracted from the light data, and the resulting values are used as the target. Note that a prior normal scan
must have previously been acquired by the spectrometer. Note also that this scan sub-type may not produce as
accurate tesults as the normal scan, where dark/light data are both acquired.

Example: “T 0<cr>” — acquire a normal target scan.

Example: “T 1<cr>" — acquire a special target scan.

Normal Response: "t<cr><If><SIG><Cttl-Z>" - This response is sent back to the client after the target scan is
complete. The target scan may take up to 30+ seconds to complete, depending on the instrument's current "Scan
Time" or “Coadds” setting. Following the normal three character response “t<cr><If>”, the entire <SIG> format
text file (containing the last reference, target, and reflectance data) will be transmitted back to the client, followed
by the single <Ctrl-Z> (end-of-file, ascii code 26) character. The <SIG> file will typically be somewhere between
32K and 64K characters in length.

Note that the <SIG> format file itself has embedded <cr> and <If> characters.

See Appendix B — File Descriptions for a complete description of <SIG> file formats.

Error Response: "E: Target Scan Error<ct><If>" - An error occurred while taking a target scan. This could be
caused by a timeout or other communication error between the PC and the instrument.

Error Response: "E: Target SIG File Open Error" - An etror occurred while attempting to open the SIG file in
preparation to sending the target data back to the client.

Error Response: "E: Wrong Number Of Parameters<cr><If>" — The client sent the wrong number of parameters
for this command.

Error Response: "E: Parameter Value Error" — The client attempted to set a parameter outside of it’s range of
valid values for this command.
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Optic Command

Command: "O a<cr>" - This one-parameter command changes the instrument’s fore-optic.
Parameter “2” (the fore-optic) — min: 1 max: 8 increment: 1 - one of the eight available fore-optic values.
Example: “O 2<cr>” — sets the current fore-optic to 2.

Normal Response: "o<cr><If>" - This three-character response is sent back to the client after the optic has
successfully been selected.

Error Response: "E: Wrong Number Of Parameters<cr><If>" — The client sent the wrong number of parameters
for this command.

Error Response: "E: Parameter Value Error" — The client attempted to set a parameter outside of it’s range of
valid values for this command.

Integration Time Command

Command: "I g b ¢<cr>" - This multi-character, three-parameter command changes the instrument’s integration
time setting, and selects between auto- and fixed-integration:

« 2

Auto-Integration: Parameter “2”, “/” and “¢” are all set to the special value of 0 (zero), and so the instrtument
g bl
determines the actual optimal integration times for each spectrometer.

Fixed-Integration: Parameters are set as follows:

« 2

Parameter “2” — (Si Spectrometer integration time, mS) — min: 10 max: 1000 increment: 10; values between 10 mS
and 1000 mS that do not lie on boundaries of 10 mS will be silently rounded to the nearest 10.

Parameter “/” — (Swirl Spectrometer integration time, mS) — min: 1 max: 40 increment: 1.

Parameter “/” — (Swir2 Spectrometer integration time, mS) — min: 1 max: 10 increment: 1.

Example (Auto-Integration): “I 0 0 0<cr>" — sets auto-integration mode.

Example (Fixed-Integration): “T 400 24 8<cr>” — fixes integration times (mS): Si: 400, Swirl: 24, Swir2: 8.
Normal Response: "i<cr><If>" - This three-character response is sent back to the client after the integration

mode/times have successfully been set.

Error Response: "E: Wrong Number Of Parameters<cr><If>" — The client sent the wrong number of parameters
for this command.

Error Response: "E: Parameter Value Error" — The client attempted to set a parameter outside of it’s range of
valid values for this command.

Scantime Command

Command: "S a<cr>" - This one-parameter command sets the instrument’s scan timing to a fixed number of
seconds; note that this command overrides any prior Coadds Command that may have set the instrument’s scan
timing to a fixed number of coadds.
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Parameter “4” (the scan time, seconds) — min: 1 max: 15 increment: 1 — the fixed scan time.
bl
Example: “S 4<cr>” — sets the scan time on any subsequent reference/target scans to 4 seconds.

Normal Response: "s<cr><If>" - This three-character response is sent back to the client after the scan timing has
successfully been set.

Error Response: "E: Wrong Number Of Parameters<cr><If>" — The client sent the wrong number of parameters
for this command.

Error Response: "E: Parameter Value Error" — The client attempted to set a parameter outside of it’s range of
valid values for this command.

Coadds Command

Command: "C a b ¢<cr>" - This three-parameter command sets the instrument’s scan timing to require a fixed
number of coadds (subject to a maximum total scan time) from each spectrometer; note that this command
overrides any prior Scantime Command that may have set the instrument’s scan timing to a fixed number of
seconds.

Parameter “2” — (Si Spectrometer coadds) — min: 2 max: 500 increment: 2; values that are not even are silently
rounded to the next even value.

Parameter “/” — (Swirl Spectrometer coadds) — min: 2 max: 500 increment: 2; values that are not even are silently
rounded to the next even value.

«

Parameter “/” — (Swir2 Spectrometer coadds) — min: 2 max: 500 increment: 2; values that are not even are silently
rounded to the next even value.

Example: “C 10 200 300<cr>" — sets the scan timing to require 10 Si spectrometer coadds, 200 Swirl
spectrometet coadds, and 300 swit2 spectrometer coadds on any subsequent reference/ target scans.

Normal Response: "c<ct><If>" - This three-character response is sent back to the client after the scan timing has
successfully been set.

Error Response: "E: Wrong Number Of Parameters<cr><If>" — The client sent the wrong number of parameters
for this command.

Error Response: "E: Parameter Value Error" — The client attempted to set a parameter outside of it’s range of
valid values for this command.

Unknown Command

Command: <unknown> - an unrecognized command of some kind has been received by the server. The
command is not one of those listed above.

Error Response: "E: Unknown Command - <unknown><cr><If>" - This response flags any unrecognized

command received by the server. The client should close down, and re-establish the socket connection in order to
recover from this error.

Busy Error

If a new command is sent from the client before the previous command has completed, the server responds with an
“E: Busy<cr><If>" message.
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Appendix I — Fiber Optic Installation

The instrument’s fiber optic adapter installs the same way as the various foreoptic lenses. Similar to these lenses it
has a pin to set a constant clock angle with the instrument which is especially important when using the fiber optic
to maintain a stable radiometric calibration for correct data acquisition.

1. Remove any foreoptic lens that is currently installed by turning the knurled retaining ring CLOCKWISE while
facing the instrument noting that the threads are right handed and the retaining ring has to move towards the
instrument.

2. Orient the fiber optic adapter so that the clocking pin is face-up, as shown below: CAUTION — DO NOT
ALLOW ANY FOREIGN MATERIAL TO ENTER THE INSTRUMENT CAVITY AS IT MAY
INTERFERE WITH THE FIBER ADAPTER INSTALLATION, DAMAGE THE INTERNAL
OPTICS OR EFFECT THE INSTRUMENT’S RADIOMETRIC CALIBRATION.

FOREOPTIC FIBER OPTIC  CLOCKING
RETAINING RING ADAPTER PIN

Figure 13, Fiber optic installation

3. Rotate the retaining ring counterclockwise while holding the fiber optic adapter clock angle until the pin feeds
into its locating hole. Hand tighten the retaining ring.
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Appendix ] — Optional Fan Installation

WARNING: If the optional fan assembly is installed on the instrument’s heat sink, do not operate the
instrument unless the fans are actually turning and providing cooling air to the heat sink. Installing the

fan assembly onto the heat sink without running the fans can cause undesirable thermal effects on the
instrument.

The optional fan module (shown below) is attached to the bottom of the instrument to provide additional cooling.

ON/OFF
SWITCH

CAPTURED
FASTENER
(4 PLACES)

POWER V4
CONNECTOR :

o

Figure 14 Fan Module

1. Carefully place the instrument on a sturdy work surface with the optical plate (bottom of the instrument) facing
up, as shown below. If present, remove the four “Filler Fasteners” — these occupy threaded holes that will be
used later by the installed fan module.

FILLER FASTENERS FAN MODULE
(4 PLACES) POWER JACK

Figure 15 Instrument Optic Plate Prior To Fan Module Installation
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2. Orient the fan module on the bottom of the instrument as shown below. Tighten the four captured fasteners
mounted on the fan module, and plug the fan module power connector into the power jack on the bottom of
the instrument.

Figure 16 Instrument Optical Plate After Fan Installation
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Appendix K— Aux Port Specification

The round connector labeled “AUX” on the instrument’s back panel has multiple uses:
e An RS-232 serial communications interface for PC/PDA host communication.
*  Multiple external trigger inputs — Reference, Target, and Current Setting.
*  Scan-in-progress output — provides a signal to external devices when a scan is in progress.
*  Battery power for powering external devices — Vpar (6.5-8.5 VDC) @ 500 mA maximum cutrent.

Connector (Female): Hirose P/N HR10-10R-128(73)
Mating Connector (Male): Hirose P/N HR10-10P-12P(73)

Figure 17 AUX Port Pinout

The following table specified the function associated with each AUX Port connector pin:

Pin Direction Signal Name Function

1 Output Vear Supplies unregulated battery voltage to an external device;
battety voltage is 6.5 — 8.5 VDC @ 500mA maximum
current draw.

2 n/a Reserved Do Not Connect, reserved for future use.

3 Input Reference Trigger Normally open; shorting this pin to Ground will initiate a
Reference scan.

4 Input Target Trigger Normally open; shorting this pin to Ground will initiate a
Target scan.

5 Input Current Scan Trigger Normally open, shorting this pin to Ground will initiate a
scan of the type currently selected in the LCD user
interface.

6 n/a Reserved Do Not Connect, reserved for future use.

7 Output Scan In Progress Normally open; this pin will be shorted to Ground by the
spectrometer electronics while a scan is in progress.

8 Output Ground Power Return / Signal Ground.

9 n/a Reserved Do Not Connect, reserved for future use.

10 Output Host Comm TX RS-232 PC/PDA host connection.

11 Input Host Comm RX RS-232 PC/PDA host connection.

12 Output Host Comm GND RS-232 PC/PDA host connection.
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Appendix W — Spectralon® Care / Handling

General Care

Care should be taken to prevent contaminants such as finger oils from contacting the material’s surface. Wear clean
gloves when handling Spectralon.

Cleaning Instructions

If the material is lightly soiled, it may be air brushed with a jet of clean dry air or nitrogen. DO NOT use Freon.
For heavier soil, the material can be cleaned by sanding under running distilled water with 220-240 grit wet or dry
emery cloth until surface is totally hydrophobic (water beads and runs off immediately). Blow dry with clean air or
nitrogen or allow to air dry.

In order to preserve the integrity of the frame it is suggested that the PTFE panel be removed prior to wet sanding.

Better results are produced using a flat surface sanding block during sanding operations.

The following pages may contain Spectralon® reference panel related information when this manual is supplied in
hardcopy form along with a instrument order that includes a reference panel.
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Appendix X — Insttument Quality Checklist

The following pages may contain an instrument-specific quality assurance checklist for a particular serial number
instrument, when this manual is supplied in hardcopy form along with a new or re-calibrated instrument.
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Appendix Y — Instrument Default Settings

The following pages may contain one or more instrument-specific default values (recommended ovetlap removal,
matching parameters, etc.) for a particular serial number instrument, when this manual is supplied in hardcopy form
along with a new or re-calibrated instrument.
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Appendix Z — Instrument FOV Diagram(s)

The following pages may contain one or more instrument-specific field-of-view diagrams for a particular serial
number instrument, when this manual is supplied in hardcopy form along with a new or re-calibrated instrument.
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